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Abstract

An oronasal defect created by the surgical resection of the palate and maxilla can be directly
obturated by a hand-kneaded maxillofacial prosthesis, the so-called immediate surgical obturator
(ISO). The ISO consists of a transparent baseplate and silicon putty obturator. The obturator
replaces hard and soft tissue, thereby improving deglutition and mastication, speech
enhancement, avoiding contamination, and improving the overall quality of life [1], [2]. Besides
the advantages of the maxillary prosthesis, the ISOs are, on the other hand, large, high-weighted,
and unstable, especially in large defects. The hand-kneaded silicone putty obturator is also porous
and susceptible to fluid and bacterial uptake, which further increases the weight, and results in a
foul smell [3]. These disadvantages often reduce the patient’s function and comfort. Creating a
hollow maxillary obturator could reduce the weight of the prosthesis by 7 - 33 %, depending on
the size of the defect [4]. Computer-aided design and manufactured (CAD/CAM) designed
obturators may overcome the limitations of the conventional method. This thesis aimed to
investigate the shape, volume, clinical fit, weight reduction, and material properties of a novel
designed CAD/CAM prosthesis, the so-called closed surface model (CSM) obturator.

In this study, CT and intraoral scanning technology were used for the image acquisition of
the novel CAD/CAM ISOs. An existing CAD/CAM workflow was optimized and used to design and
print different scaled CSM obturators around the segmented bone and soft tissue, in Clear resin.
The clinical fit of the prostheses was evaluated in a clinical trial study with four included
maxillectomy patients in the Netherlands Cancer Institute—Antoni van Leeuwenhoek Hospital
(NKI-AVL). In addition, the CSM obturators were evaluated with a retrospective study of
maxillectomy patients from 2010 to 2020 in the NKI-AVL (n = 17). The criteria included patients
with a pre-and postoperative CT scan, in which the conventional obturator could be segmented
from the postoperative scan based on greyscale thresholding. The skulls of both scans were also
segmented and registered to obtain the resection margins, which were classified according to the
novel Ooms’ classification system. The CSM obturators were then designed according to this
classification system and compared with the conventional and theoretical reference obturators by
weight reduction and Hausdorff Distances (HD). Furthermore, this study investigated whether the
material of the CAD/CAM ISOs was stable in a simulated oral cavity environment of 37°C heated
water. In addition, the fracture mechanic performance during the removal of the prosthesis in the
patient’s mouth was researched by a compressive resistance test. The outcome of the maximal
fracture load was used for a digital Finite Element Analysis to study the tensile stress and
deformation in Ansys.

Our clinical results showed that the shape and volume of the conventional obturator
depend on the height of the resection and whether the canine was resected. This resulted in
different CSM design choices per Ooms’ class. The 0.8 scaled CSM around segmented resection
margins showed the overall best clinical fit with a clinical weight reduction between 36 - 39%. In
the retrospective study, the average weight reduction of the CSM obturator was about 47%, which
was similar to the theoretical clinical reference. In the material property study, the prosthesis had
a water absorption of 2%, and material deformation occurred at the thinnest, lateral side of the
baseplate. The fracture load during the prosthesis removal was 25 N which indicated that the
prosthesis was safe for usage.

Future studies should focus on the improvement of the final workflow and prosthesis
design to enable the clinical implementation of the CAD/CAM obturators. The improvements
should include a more automated workflow, integrated into a user interface, and adjustments in
the baseplate design to gain retention o to the remaining bone structures and teeth. Furthermore,
the finalized designs should be evaluated within a large cohort clinical-trial study, comparing the
conventional obturator with the novel CSM obturators. The clinical-trial findings will gain insight
into the impact of the amount of weight reduction on the patient’s comfort improvement.
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1. General introduction

This thesis is about fabricating novel 3D printed maxillofacial (upper jaw) prostheses, the so-
called immediate surgical obturators. The prosthesis is used to close and maintain the surgical
defect between the oral and nasal cavities after a maxillectomy procedure, to improve talking,
chewing, and swallowing. Maxillectomy surgery is most commonly required to treat squamous
cell carcinomas that problem statement, and thesis outline.

1.1 Clinical background

1.1.1 Anatomy maxillae

The maxillae, the upper jaw, are a pair of symmetrical bones that unite at their midline, the so-
called intermaxillary suture [5], [6]. The bones separate the nasal and oral cavities and play a
significant role in mastication, communication, and facial appearance [7]. As seen in Figure 1.1,
each maxilla bone consists of a body with four processes: the alveolar-, zygomatic-, frontal-, and
palatine process. The alveolar process holds up the maxillary dental arch [7]. The palatine process
of the maxilla (Figure 1.1b-c), together with the horizontal plates of the palatine bone, form the
hard palate, separating the oral cavity from the nasal cavity. The hard palate is connected
posteriorly to the soft palate: a mobile structure consisting of muscle fibers and connective tissue
covered by a mucous membrane. The soft palate lifts the nasopharynx to demarcate the
oropharynx to the nasopharynx [8].

Palatine
proces
. Frontal Frontal
: proces .
Inferior .
orbital Zygomatic
foramety [y proces Palatine

Alveolar
proces

Figure 1.1. Anatomy of the maxillae bone (green). a) Anterior view. b) Inferior view. c)
Sagittal view [7].

The maxilla bone consists of a hollow space: the maxillary sinus. The maxillary sinus is
one of the four paired paranasal sinuses, each named after the bones that contain them: frontal,
macxillary, ethmoid, and sphenoid (see Figure 1.2). The maxillary sinus is shaped like a pyramid
and is the largest of the four, producing the nose mucus [9]. The maxillary sinus has its apex
towards the zygomatic process and is surrounded by the lateral border of the nose, the alveolar
process, and the orbital [10].
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Paranasal Sinuses

|
i

h‘,w;*Frontal sinus

Figure 1.2. Anatomy of the four paired paranasal sinuses [9].

1.1.2 Musculature

The maxillae are surrounded by muscles of mastication and facial expressions. The masseter is
the strongest mastication muscle, which derives superficially from the zygomatic process of the
maxilla. Several other muscles originate from the maxilla, including the nasalis, levator labii
superioris alaeque nasi, levator labii superioris, and levator anguli oris. The orbicularis oris
muscle encloses the mouth, in which the intrinsic fibers originate from the alveolar process of the
maxilla and mandibular incisors [11], [12].

1.1.3 Blood supply & innervation

The maxillary artery provides most of the blood supply to the maxillae, which derives from the
external carotid artery. As seen in Figure 1.3a, the maxillary artery branches into the alveolar- and
infraorbital artery, which passes the infraorbital foramen. The additional blood reaches the
maxilla through the soft palate, which derives from the facial artery, lingual artery, and the

ascending pharyngeal branch of the external carotid artery [11], [13].

1. Ophthalmic a. /
2. Infraorbital a.

3. Deep temporal a.

4. Posterior superior alveolar a.
5. Middle superior alveolara. .
6. Anterior superior alveolar a. ’

7. Buccal a.

8. Inferior alveolar a.

9. Middle meningeal a.
10. Maxillary a.
11. Superior temporal a.
12. Extemal carotid a.
13. Mental branch of inferior

alveolar a. -

14. Facial a.

1. Maxillary n. (
2. Pterygopalatine ganglion
3. Infraorbital n. 4

4. Posterior superior alveolar n.
5. Middle superior alveolar n.
6. Anterior superior alveolar n.
7. Buccal n.
8. Mandibular n.
9. Lingual n.

10. Inferior alveolar n.

11. Nerve to mylohyoid

12. Auriculotemporal n.

13. Mental branch of inferior

alveolar n.

Figure 1.3. Schematic overview of the maxillary blood supply and nerve innervation. a) The
macxillary artery and its facial branches derive from the external carotid artery. b) The
maxillary nerve derives from one of the three branches of the trigeminal nerve [13].
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The maxillae are innervated by the maxillary nerve, as shown in Figure 1.3b. The maxillary
nerve derives from one of the three branches of the trigeminal nerve (cranial nerve V) and
branches into the infraorbital nerve through the infraorbital foramen. Furthermore, the posterior
superior alveolar nerve and the zygomatic branch derive directly from the maxillary nerve [14].

1.1.4 Epidemiology

Cancers of the nasal cavity and paranasal sinuses are rare, with an incidence of <1% of all
malignant tumors and including 5% of head and neck cancers. About 90% of head and neck
cancers are squamous cell carcinoma (SCC), they develop in the nasal cavity, maxillary sinuses, or
the palate. [15]-[17]. Maxillary sinus SCC is a relatively rare and aggressive type of neoplasm and
has the highest incidence (60%-70%) compared to the other paranasal sinuses. The disease is
often (>80%) discovered late in an advanced stage. Palate SCC has a lower incidence compared to
the MSSCCs, they arise from the squamous epithelium of the oral mucosa [18]. Chemicals, viruses,
smoking, and alcohol are high-risk factors for this type of tumor, and it mainly affects middle-aged
men (55-65 years) from Eastern countries [19], [20].

The most common incidence of SCC is followed by adenoid cystic carcinomas (ACC) which
comprise 1% of all malignant neoplasms in the oral cavity and maxillofacial area. The ACC
develops in the mucus glands in the maxillary sinuses. Other nasal, paranasal sinuses, and palate
tumor types include adenocarcinoma, mucoepidermoid carcinoma, undifferentiated cancer, and
occasionally, malignant melanoma [16], [21].

1.1.5 Maxillectomy approaches

The treatment of the maxilla and palate SCC’s are based on the tumor size, node, and metastasis
(TNM) staging and grading [22]. Except for T1, when there is no bone erosion or destruction, the
tumor is usually surgically treated by a maxillectomy, followed by postoperative radiation therapy
[23], [24]. A maxillectomy is the removal of all or part of the maxilla bone. The surgical excision is
challenging due to the complex anatomy, the surrounding critical structures such as the eyes and
cranial nerves, and the advanced stage of the tumor. The tumor often extends to adjacent tissue,
such as the (soft) palate, midface, and orbits which will be further described in the following
section [19], [25], [26].

There are several approaches for a maxillectomy (see Figure 1.4), depending on the size, type,
aggressiveness, and localization of the tumor:
e Lateral rhinotomy: an incision lateral to the nose for a medial maxillectomy without
extension to the palate or orbit as seen by the red dotted line of Figure 1.4 a.

S

a b C

Figure 1.4. Schematic overview of surgical approaches for a maxillectomy. a) Lateral
rhinotomy (red line) and Weber-Ferguson (blue line) incision. b) Elevated myocutanous flap
showing the maxilla (*) orbicularis oris muscle (= ) and infraorbital nerve (>). c¢) Facial
degloving: transfixion and gingivobuccal incision (black arrow) [27], [86].
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e Weber-Ferguson: an extended lateral rhinotomy incision to the orbit and lips to reach
the palate as seen by the blue dotted line of see Figure 1.4 a.

e Facial degloving: Exposure of the midface, alternative to the lateral rhinotomy (see
Figure 1.4 c). This is the most minimally invasive procedure because of the major
advantage that no external facial incisions are needed [27]-[29].

1.1.6 Maxillectomy classifications

There are several ways to classify maxillary defects. Classification systems can guide the planning
of a maxillectomy and reconstruction. Several classification systems exist, like Aramany’s (1987),
which divided the maxillary defect with the abutment teeth into six categories. Spiro et al. (1997)
came up with a simple system that divided the maxillary resection into either limited, subtotal, or
total. The Brown et al. (2000) classification, the most commonly used system, classifies both in the
horizontal and vertical direction as visualized in Figure 1.5 and described in Table 1.1 [30], [31].

Figure 1.5. Brown's classifications for maxillary defects (red areas), divided into a horizontal
(upper panel a-d) and a vertical component (middle and lower panel I-VI) [18].

==

UNIVERSITY ANTONI 8)
OF TWENTE L[EUWE.I‘\JII{‘\CS%I%QI;. "\



General introduction

Table 1.1. Brown’s classification of maxillary defects [25].

Vertical

Class 1 Maxillectomy without an oronasal fistula.

Class I Macxillectomy not involving the orbit.

Class 111 Maxillectomy involves the orbital adnexa with orbital retention.

Class IV Maxillectomy with orbital enucleation (eye removal) or exenteration (entire
orbital removal).

Class V Maxillectomy with an orbitomaxillary defect.

Class VI Maxillectomy with a nasomaxillary defect.

Horizontal

a Only palatal defect without the dental alveolus.

b The palatal defect is less than or equal to half unilateral.

C The palatal defect is less than or equal to half bilateral or transverse anterior.

d The palatal defect is larger than half maxillectomy.

1.1.7 Reconstruction of the maxillary defect

To reconstruct the maxillary defect and therefore improve the deglutition and mastication,
speech, and the overall quality of life, several reconstructive options exist. The reconstructive
options are still evolving from either using an obturator prosthesis, or surgical reconstruction
methods (i.e., regional soft tissue and or bone flaps, free soft tissue and or bone flaps, autogenous
implants, and alloplastic implants) [2][32].

This research, however, focuses on the obturator prosthesis as the permanent reconstructive
method, which is the most used treatment worldwide due to its safety and has the least operative
time [33]. The obturator can replace both hard and soft tissue to close the oral and nasal cavities.
Also, the obturator has the advantage that it can immediately restore dentition, and improve the
facial appearance [2]. In addition, the obturator allows for a simplified clinical examination of the
treated area compared to the other reconstructive approaches, which is important for possible
early detection of tumor recurrence after removal [23], [33]. The maxilla obturators are classified
into three types:

- Immediate surgical obturator: inserted at the time of surgery.

- Interim obturator: fabricated two-four weeks after surgery.

- Definitive obturator: fabricated three-six months after surgery [32].

Immediate surgical obturator

The immediate surgical obturator (ISO) refers to immediate coverage of the palatal defect. Before
surgery, the prosthodontist discusses the planned surgical treatment with the surgeon to
determine the incision and amount of resection. Next, the prosthodontist obtains a dental
impression of the patient with an irreversible hydrocolloid. The impression is poured into a dental
stone to create a dental plaster cast [34][35]. The prosthodontist marks the discussed resection
margins on the cast and sends the cast to a dental lab to create a working cast. The alveolar
resection margins are removed from the working cast, and the so-called C-claps retention wires
are created around the remaining teeth. The C-claps are fabricated from stainless steel
orthodontic wires. Next, a 2 mm thick transparent baseplate is fabricated from the working cast
using heated polymerizing clear acrylic resin. The transparency of the baseplate allows visible
inspection of the clinical fit [1], [34].

The obturator is hand-kneaded by the prosthodontist in the operation room (OR) directly
after the tumor resection. The prosthodontist uses a moldable thermoplastic material to create a
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bulb on top of the baseplate [35]. Figure 1.6 shows two ISOs, both three weeks post-operative for
(a) a hard palate defect using silicone putty and (b) a soft palate defect using flexible silicone. This
study, however, focuses only on the hard palate defects. The bulb is fabricated greater than the
maxillary defect, mostly at the lateral side, to prevent sunken cheeks. For large palatal defects, a
split-thickness skin graft is used to create a layer between the defect and the mucosa junction and
creates stabilization of the prosthesis [32]. The prosthesis is stabilized by retention wires, which
are connected to the temporal process of the zygomatic process (Figure 1.7), or hooked around

Figure 1.6. Two examples of the immediate surgical obturator (ISO), both three weeks post-
surgery. a) An ISO for a hard palate defect. b) An ISO for a soft palate defect.

the patient teeth [4], [36]. For edentulous patients and total maxillectomy patients, palatal bone
screws, titanium implants, or sutures into the surrounding mucosa can also be used to retain the
prosthesis. In case of severe bone atrophy, circumzygomatic wiring for edentulous patients is the
easiest and most cost-effective method [32], [37].

Point of entry
of the awl

Point of entry
A\ Wire - into the oral cavity

Figure 1.7. Schematical illustration of circumzygomatic wiring [87].

Interim obturator

After 2-4 weeks of surgery, the wound has altered in shape and size due to the quick soft tissue
changes that take place within the defect during the healing of the wound. The obturator could
consequently be too loose or too tight. Therefore, an interim obturator can be created, by relining
the existing prosthesis or by creating a new one [32]. The interim obturator is periodically
readapted or relined to fit with the tissue adjustments [4]. A new obturator is often fabricated
from acryl resin with wire claps around the remaining teeth [23], [38].
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Definitive obturator

After three to six months, when the defect is completely healed, a definitive obturator is fabricated
(see Figure 1.8). The definitive obturator consists of a metal framework of cobalt-chromium,
which offers retention, support, and stability [32], [39]. The design of the definitive obturator
depends on the size and the shape of the defect, and the absence/presence of the remaining teeth
[23]. The prosthesis must have enough retention but without difficulty during insertion and
removal of the prosthesis by the patient. Follow-up adjustments of the prosthesis are necessary
to optimize speech and nasal leakage of fluids [40].

Figure 1.8. Definitive obturator prosthesis [88].

1.2 Problem statement

1.2.1 Conventional obturators

Besides the advantages of the maxillary prosthesis, the immediate surgical obturators are, on the
other hand, large, high-weighted, and unstable. The size and weight depend on the maxillary
defect, in the case of a large defect, the obturator can weigh about +70-80 grams. The challenge in
heavily weighted obturators is to obtain adequate retention. Besides, the silicone putty is also
porous and susceptible to fluid and bacterial uptake, which further increases the weight and
results in a foul smell [3]. These disadvantages often reduce the patient’s function and comfort.
Creating a hollow maxillary obturator could reduce the weight of the prosthesis by 7 - 33 %,
depending on the size of the defect [4].

Furthermore, the fabrication of the prosthesis can be rather challenging, including material
dispensing, packaging, and shipping. Also, at the lab, the materials need to be plastered, poured,
die-cutting, and more [4], [41], [42]. In addition, the tight collaboration between the
prosthodontist and the surgeon can be logistically challenging. Besides logistical and time-
consuming limitations, the hand-kneaded shape of the obturator is experience-based by the
prosthodontist. The varying shapes can lead to an unpredictable obturator fit, loss of retention,
and pain [1].

1.2.2 Concept CAD/CAM workflow

Computer-aided design and computer-aided manufacturing (CAD/CAM) designed obturators may
overcome the limitations of the conventional method. Researchers at the Netherlands Cancer
Institute—Antoni van Leeuwenhoek Hospital (NKI-AVL) designed an in-house concept CAD/CAM
technology workflow for fabricating a 3D printed baseplate and a hollow bulb obturator [43]. The
2 mm thick air-filled bulb is merged to a baseplate, designed from a TRIOS 3Shape (Copenhagen,
Denmark) intraoral scan (I0S) of the upper teeth and palate, as seen in the different views of
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Figure 1.9. The hollow bulb concept CAD/CAM workflow indicated great potential in reducing the
weight compared to the solid putty obturator and, as a result, improving the patient’s comfort
with future I1SOs [43].

Figure 1.9. Hollow bulb immediate surgical obturator design. a) Frontal-lateral view. b)
Dorsal-medial view. ¢) Sagittal cross-section of hollow bulb [43].

The hollow bulb design, however, is limited to its round shape and does not correspond
entirely with the varying shape and size of the conventional ISO. Contrary to the design, the
conventional ISO tends to exceed the bony resection margins, especially in larger defects.
Increasing the size and improving the shape of the CAD/CAM obturator would gain more weight
reduction and, as a result, increase the patient’s comfort. Recreating the exact shape, however, can
be rather difficult because no research has been published yet about the different types and
shapes of the [SOs. In addition to the shape, the overall concept CAD/CAM workflow contains steps
that require manual decision-making and is rather complex. Furthermore, the clinical fit of the
hollow bulb obturator shape highly depends on the performance of the surgeon. Finally, the design
and workflow cannot be clinically implemented yet; it lacks sufficient clinical usage components
such as the C-claps and a boulder for circumzygomatic wiring. An optimized obturator shape and
workflow could overcome these disadvantages.

1.3 Objectives

This research aims to create a user-friendly workflow for the fabrication of novel optimized
hollow immediate surgical obturators. Based on the stated problems, the main objective of this
research is:

Create a user-friendly computer-aided design and manufacturing workflow for the
fabrication and clinical implementation of the 3D printed hollow immediate surgical obturator to
improve the clinical fit, reduce the weight, and increase the maxillectomy patient’s comfort.

The research is divided into 3 objectives:

1. Develop an optimized and user-friendly concept workflow containing a novel obturator
design.

2. Develop a classification system for the ISO shape prediction to gain an improved clinical
fit and weight reduction and therefore increase the patient’s comfort.

3. Research the material properties and structural safety of the CAD/CAM design.

==
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1.4 Thesis outline

This thesis is divided into four chapters. After the general introduction, the workflow and clinical
fit during several maxillectomy’s of the novel CAD/CAM-designed obturators are described. The
third chapter describes the retrospective study, which compares the shape, volume, and weight
reduction between the conventional and CAD/CAM-designed ISOs. Finally, the fourth chapter
describes the mechanical properties of one of the digitally designed prostheses.

1.5 Technical background

1.5.1 CAD/CAM obturators

Recently, several studies started with the design of CAD/CAM obturators to overcome the
disadvantages of the conventional method. Besides the fabrication of obturators, CAD/CAM has
been used successfully for improved prosthetic dentistry fabrication for many years, allowing
virtual surgical planning with high accuracy, which also saves time and cost [41], [44]. For
example, Noh et al. (2016) used CAD/CAM technology to fabricate zygomatic implants for
additional support of a maxillary prosthesis. In addition, Soltanzadeh et al. (2019) used CAD/CAM
technology for a 3D-printed metal framework for a maxillofacial prosthesis [44].

For the imaging acquisition of the CAD/CAM prosthesis, besides imaging techniques such
as CT and MR], intraoral scanning technology can be of use. This optical imaging technique is easy-
to-use, light-weighted, and cost-effective, using confocal microscopy to increase the optical
resolution and contrast [42], [45]. Michelinakis et al. (2020) compared the accuracy of three types
of I0S in which the TRIOS 3Shape 10S being the most precise scanner according to their research
(see Figure 1.10) [46]. Furthermore, a recent study by Brucoli et al. (2020) used the TRIOS 3Shape
I0S for the fabrication of a definitive obturator prosthesis for twenty-eight patients with a
maxillary and/or palatal defect [42]. In addition, Koyama et al. (2019) designed a 3D printed
workflow using I0S for definitive hollow bulb obturators [47].

Figure 1.10. The 3Shape TRIOS intraoral scanner [89].

Figure 1.11 shows schematically the differences between the conventional solid putty
obturator and a 3D printed hollow CAD/CAM surgical obturator with tissue conditioner (TC).
Hollowness instead of a solid obturator decreases the weight of the obturator [48]. The tissue
conditioner is a soft lining material, a mixture of powder and liquid in which several brands exist,
the NKI-AVL uses Coe-soft. The use of tissue conditioner for a CAD/CAM obturator, instead of the
conventional molding material putty, is because of the difference in tensile bond strength to the
3D print [49]. As seen on the inside of the CAD/CAM obturator in Figure 1.11, the air-filled
obturator consists of a thin 3D printed layer of a transparent Clear resin (Clear). The surrounding
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layer of tissue conditioner enables a precise clinical fit, increases the patient’s comfort, and allows
post-operative adjustments in the follow-up visits.

CAD/CAM

Figure 1.11. Schematically illustrated differences between the conventional solid putty
obturator (left panel) and the hollow computer-aided and manufactured (CAD/CAM)
obturator. The air-filled CAD/CAM obturator consists of a thin layer of clear resin, surrounded
by tissue conditioner, which is a soft denture lining material.
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2. Clinical evaluation of
the CSM obturator

2.1 Introduction

Recently, several pilot studies have been published about the fabrication of hollow CAD/CAM-
designed ISOs to reduce the weight of the conventional ISO. For example, the study by Dartaguiette
et al. (2021) used the contours of soft tissue in segmented cadavers from CBCTs to develop
CAD/CAM-designed ISOs [50]. Kortes et al. (2018) used both MRI and CT to create the obturator
based on the tumor contours [1]. However, both workflows are complicated, time-consuming, and
experience-based and thus not user-friendly. In addition, they did not consider that the CAD/CAM
design needs to be cable of being reduced in size by the prosthodontist during the follow-up visits.
Creating a more automatized method for the varying shapes and sizes of the obturator is therefore
necessary.

2.1.1 Previous work: the hollow bulb obturator

As mentioned in the previous chapter, the NKI-AVL started researching a concept CAD/CAM
workflow for the fabrication of a baseplate and round hollow bulb obturator [43]. This workflow
of A. Steenhuis uses CT scans and intraoral scanning technology for the design of the prosthesis.
The hollow bulb design consisted of fitting and resizing a sphere around the bony resection
margins as seen in Figure 2.1. Although the workflow has the potential in obtaining a generalized
shape for the obturators, it can be optimized in terms of fewer technical and manual steps. Also,
the workflow is limited to its round shape, which is contrary to the shape of the conventional ISO,
which exceeds the resection bone to find its support in surrounding soft tissue.

1. Select outermost 2. Create and fit 3. Resize sphere
boundaries resection sphere
margins

Figure 2.1. Workflow of the computer-aided and manufactured designed hollow bulb
immediate surgical obturator in MATLAB (version: R2021a, MathWorks, USA). 1. The
selection of the outermost boundaries of segmented resection margins from a pre-operative
CT scan. 2. A graphical sphere is fitted around the resection margins. 3. The sphere is reshaped
and translated to fit the segmented resection margins.
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2.1.2 Hollow closed surface model

This study aims to improve the concept digital NKI-AVL workflow by using a novel method to
improve the obturator design, it is called the closed surface model (CSM) obturator (see Figure
2.2). This method fabricates a CSM automatically around all outermost resection boundaries.
Figure 2.2 shows an example of a segmented maxilla and its resection bone (blue) from a CT scan.
A yellow CSM shape is then automatically fabricated by following the outermost surface points of
the resection bone. For larger resection types, the conventional ISO is larger than the resection
alone to prevent sunken cheeks. To achieve an enlarged CSM obturator volume, other segmented
surrounding tissue besides the resection bone can be included in the design. Figure 2.3 shows an
[0S of the upper jaw with examples of such segmented surrounding hard- and soft tissue which
can be included in the design. The hollow bulb and CSM shapes are both designed from the pre-
operatively planned segmented resection margins. Therefore, the way that the designs fit in the
patients ‘mouths (referred to in this study as clinical fit) also depends on the surgeon’s
performance. For this reason, it is key to intra-operatively navigate the pre-operatively virtual
planned resection margins.

1. Segmented
maxilla

2. Resection bone 3. Closed surface model (CSM)
around resection

Figure 2.2. Design steps of the closed surface model (CSM) obturator from segmented
maxillary resection margins in the open open-source software application 3D Slicer using the
‘Marksup to model’ extension.
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Intraoral scan  Resection bone Mandibula m. Buccinator m. Masseter

Cheek fat  Skin

Figure 2.3. Intraoral scan of the upper jaw with segmented CT tissues in the open-source
software application 3D Slicer. The figures include the bony resection margin (dark blue) and
surrounding soft-tissue parts: buccinator and masseter muscle (red), buccal and cheek fat
(yellow), and skin (grey).

2.1.3 Study aim

The following chapter reports the outcome of a clinical trial study of four maxillectomy patients,
aiming to evaluate the shape and clinical fit of the novel semi-automatic workflow of the CAD/CAM
designed hollow CSM obturators. After examination of the clinical fit, the surgical defect was
obturated according to the conventional method. Therefore, this study also aimed to post-
operatively compare the weight difference of these conventional putty obturators with the weight
of the CSM design. In addition, this research aimed to create a user-friendly digital workflow in
which the workflow was optimized throughout the research to obtain this goal. Different types of
CSM obturators were thus designed based on the outcome of each clinical case throughout the
study. In addition, several scales of the CSM design were researched to investigate the optimal
clinical fit, considering that the conventional ISO is polished and reduced in size during the post-
operative follow-up appointments.

2.2 Method

2.2.1. Patients

The clinical trial study included all patients who underwent a maxillectomy in the AVL-NKI
hospital during the time of research (Oct 2021 - Aug 2022). The criteria for each patient included
that a pre-operative CT scan and [0S were available. In addition, the surgical operation needed to
consider the hard palate, in which a prosthodontist obturated the defect. The inclusion left four
patients who were enrolled in the clinical trial study. Figure 2.4 shows the segmented skulls of
each patient in Slicer, with the resection margins highlighted in dark blue.
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2.2.2 CT analyses

All scans were acquired at the NKI-AVL using the same CT scanner and settings. Patient 1
underwent a PET-CT scan with a reconstructed slice thickness of 2.0 mm, performed with 140 kVp
and exposure 117 mA. The field of view was 512x512 pixels and pixel spacing was 1.17 x 1.17 mm.
The CT dose index (CTDIvo1) was 6 mGy and the dose length product (DLP) was 239.91 mGY*cm.
Patients 2-4 underwent CT scanning with a reconstructed slice thickness of 1.0 mm, performed
with 120 kVp and exposure 175 mA. The field of view was 512x512 pixels and pixel spacing was
0.47 x 0.47 mm. The CTDIy, was 22 mGy and DLP 536.1 - 635.3 mGY*cm.

Figure 2.4. Segmented skulls of each included patient (P) in 3D Slicer with the resection
margins highlighted in dark blue.

2.2.3 Pre-operative virtual surgical planning

Figure 2.6 gives a schematically overview of the NKI-AVL optimized CAD/CAM workflow for
fabricating the 3D printed hollow CSM ISOs, which will be explained further in the following
sections. First, the pre-operative head CT scan from PACS and the I0S of the upper jaw, exported
as a Stereolithography (STL) file from the TRIOS 3 Shape software, were loaded into Slicer (Slicer
4.4.0 software (Surgical Planning Lab, Harvard Medical School, Harvard University, Boston, USA).
The CT scan was used for semi-automatic greyscale thresholding of the bones [51], [52]. A region
of interest (ROI) around the maxillary resection margins was then virtually planned together with
the head-and-neck surgeon. The CT was cropped using the ROI to create a new volume to segment
and generate a resection margin model. The surgical oblique cutting direction (palatine bone
midline to the resected teeth) was obtained using a vertical plane cut through the resection model.
A detailed segmentation protocol in Slicer was developed during this research for reproductive
purposes (see Appendix Al). In addition, these steps were encoded in Python for the r
automatization of the workflow (see Appendix B1).

After finishing the resection model, the 10S was registered to the teeth of the segmented
skull using manually selected fiducial point-based rigid-body registration (FPR) by the ‘Slicer IGT’
extension [53]. For the FPR, an average of four to five fiducial points were used on distinctive
characteristics of the teeth (Figure 2.5A). The manual FPR was chosen due to the height difference
between the scanned hard palate mucosa and the segmented hard palate bone (Figure 2.5B). The
height difference results in a wrong point correspondence when choosing an automatic
registration method such as the iterative closest point (ICP) algorithm. The ICP registration finds
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aRA

1. CT head
Radiologist
[PACS]

2. Intraoral scan
Prosthodontist
[TRIOS]

3. Segmentations
Skull & resection margins
[3D Slicer]

v

4. Fiducial point
> registration
[3D Slicer]

4

‘\N\f\(

5. CSM design
From resection margins
[3D Slicer]

N

6. Baseplate design
From registered 10S
[Meshmixer]

7. Merge and finish CSM
» & baseplate design
[Meshmixer]

8. 3D print and final
> polishing
[Preform]

Figure 2.6. Schematical overview of the Netherlands Cancer Institute—Antoni van
Leeuwenhoek Hospital (NKI-AVL) in-house concept computed-aided and manufactured
(CAD/CAM) technology workflow for fabricating a 3D printed baseplate and closed surface
model (CSM) obturator.

Fiducial Point
Registration (FPR)

FPR + ICP
(without palate)

FPR + ICP

Difference hard palate mucosa

& bone (posterior view) B

Figure 2.5. Registration of a segmented CT skull and intraoral scan (I0S) of the upper jaw. A)
Use of four manually selected fiducial point registration (FPR) points on the teeth. B)
Difference between FPR (upper left), FPR and iterative closest point (ICP) algorithm (upper
right), FPR + ICP after removal of the palate (lower left), and the height difference of the palate
of the 10S and segmented CT.

the translation and rotation matrices between two 3D point clouds to determine the minimum
distances between the points [54]. The analysis of the fiducial registration error (FRE) was
calculated by the difference in position between the matching fiducial points: the root mean
square (RMS) [53]. In addition, the FRE was visualized by computed distancing mapping between
the segmented teeth and I10S of the upper jaw. The final step in Slicer required the design of the
CSM around the resection bone by using the ‘Markups to Model’ extension (Figure 2.2). In some
of the cases, soft tissue was included in the CSM design (Figure 2.3), which will be further
explained for each case in the next sections.
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2.2.4 Baseplate design & merge

The CSM obturator was then exported as an STL file and loaded into the freeware Autodesk
Meshmixer (Autodesk Inc, San Rafael, CA). The obturator was scaled to different sizes (0.6, 0.7,
and 0.8) to investigate the balance between clinical fit and feasibility. Next, the obturator was
merged to a 2mm thick, designed baseplate made in Meshmixer from the 10S of the upper jaw.
The baseplate was designed according to the protocol of the previous NKI-AVL research. A
schematical overview of this protocol is presented in Appendix C [43]. Excessive parts were
removed and smoothed from the merged model to prevent sharp edges within the patient’s
mouth. Next, the obturator was made hollow, again with a thickness of 2mm. Hollow tubes with a
1.5mm radius were subtracted from the design to prevent 3D print failures due to the air trapping
of the hollow print [55]. Finally, the finished model was exported again as an STL file. A
schematical overview of the steps in Meshmixer is visualized in Figure 2.7.

1. Scale & create solid object
Edit > Transform > Scale
Select objects > Combine > Make Solid

2. Shrink & smooth excess parts
Sculpt > Brushes > ShrinkSmooth

3. Smooth model
Select > Deform > Smooth
(crtl + F)

A4

4. Hollow model & add tubes
Edit > Hollow (2mm)
Edit > Add Tube (1.5mm)

v
5. Inspect and export final model
Analysis > Inspector
File > Export

Figure 2.7. Schematical workflow of the merge and finish of the obturator and baseplate in
Autodesk Meshmixer. After scaling the obturator, the two objects are merged and smoothed.
The obturator is designed hollow with a 2mm thick layer in which 1.5mm tubes are subtracted
from the model to allow the air to escape during printing. Finally, after the mesh inspection,
the model is exported for printing.
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2.2.5 3D printing and final polishing

For the final finish, external supports were added to the STL models in the PreForm version 3.19.1
software (FormLabs Inc., Somerville, MA, USA). Next, the models were printed in Clear resin V4
with the Form 3 (Formlabs Inc) stereolithography (SLA) printer with a layer thickness of 100 pum.
The printing was followed by a wash in isopropyl alcohol (IPA) and a cure with UV light [56]. The
external supports and sharp edges were removed, the print was polished, and the tube holes were
closed using the dental self-curing acrylic material TAB-2000 powder.

2.2.6 Patient-specific obturator design

The patient-specific methods described in this section are in chronological order of the operations.
After each case, the methods were discussed and optimized for the next case to obtain a
standardized user-friendly workflow. This trial-and-error resulted in different numbers and types
of hollow ISOs for each clinical case. The clinical fit for the second, third, and fourth patient were
scored numerically from 1(poor) to 5(excellent) by the prosthodontist.

The first patient included the resection of the right-sided alveolar bone, from the last
molar to the canine (see Figure 2.8). Both the resection margin (blue) and skin of the cheek (grey)
were segmented to design an obturator model that reached out to the cheek. The CSM was then
cut vertically to agree with the limit of the lateral resection to prevent an overestimation in this
direction. The CSM obturator was transformed to a scale of 0.6, 0.7, and 0.8. For comparison, the
hollow bulb obturator (Figure 2.1) was also designed, leaving four designed obturator models.

lateral resection
margin

CSM bone +
Skin/soft-tissue

Figure 2.8. Workflow of the obturator design of patient nr. 1. Resection bone (blue) and skin
(grey) are segmented in which a closed surface model (CSM) is designed around the
segmented parts. The design is then cut vertically to agree with the limits of the lateral
resection margin.

The second patient included the resection of the left-sided alveolar bone across the nose
septum and three molars. The digital designs included the hollow bulb (Figure 2.1) obturator,
followed by five different obturators scaled to a size of both 0.7 and 0.8 (based on the results of
the previous case), leaving a total of 11 ISOs. Figure 2.9 gives two examples of the CSM designs:
left) a model around the resection bone, right) two combined CSM models around the section bone
and the (buccal) fat. Another CSM design included only one CSM for the resection bone and soft
tissue. The fourth design included using an I10S file of a putty obturator from a retrospective case
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with a similar resection. The final design was a proof of concept by creating the CSM model around
manually selected fiducial points. The designs endeavored to prevent overlapping of the model
with the lower jawbone. To summarize:

Hollow bulb

Two separate merged bone & soft tissue CSMs (2x)

One bone & soft tissue CSM (2x)

Retrospective intraoral scanned and fitted putty obturator (2x)
Model around manual selected fiducial points (2x)

Figure 2.9. Workflow of two obturator designs of patient nr. 2. Resection bone (blue) and
buccal fat (yellow) are segmented in which a closed surface model (CSM) is designed around
the segmented parts (right panel). In the left panel, the CSM design only surrounds the
resection bone.

CSM bone

Figure 2.10. Workflow of the obturator design of patient nr. 3. Resection bone (blue) is
segmented in which a closed surface model (CSM) is designed around the segment.
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The third patient included the resection of the left-sided alveolar bone and three molars.
One CSM was designed around the resection bone (see Figure 2.10) in three scaled sizes (0.7,
0.8.and 1.0). In addition, the hollow bulb design was created for comparison, leaving four
models in total.

The fourth patient included, like patient 1, the resection of the left-sided alveolar bone,
and molars to the canine. A CSM design scaled to 0.8 and 1.0 was created around the resection
bone (see Figure 2.11). Two other 0.8-sized designs were created by enlarging the CSM obturators
with 5 mm and 10 mm to the lateral side in Meshmixer. In addition, a zygoma wiring bollard on a
0.8 scaled model was designed, and copied from a conventional intraoral scanned ISO of one of
the other patients.

Figure 2.11. Workflow of the obturator design of patient nr. 4. Resection bone (blue) is
segmented in which a closed surface model (CSM) is designed around the segment.

2.2.7 Navigation

The in-house Fusion ENT navigation system (Medtronic, Jacksonville, FL) was used for surgical
navigation of the virtual surgical planned resection bone (Figure 2.12 A). For the navigation, the
resection margins were pre-operative saved as Nearly Raw Raster Data (NRRD) file in Slicer,
resulting in a black (0) background and white (1) contoured resection image. The NRRD volume

CT Head - Resection

Figure 2.12. Example of virtual surgical planned navigation for a partial maxillectomy. A) ENT
Medtronic navigation system (Medtronic, Jacksonville, FL). B) CT scan of the head with the
resection margin subtracted of the scan, visualized as a darker space (red arrow).
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was then multiplied with the CT scan to obtain varying greyscale values in the resection area. Next,
the multiplied volume was subtracted from the CT scan, resulting in an output volume containing
the original scan with the resection area visualized in dark grey contours (see Figure 2.12 B). The
output volume was loaded into the Medtronic navigation system for the 3D intra-operative
navigation. During surgery, the operator used a navigated pointer to mark the resection margins
on the patient before sawing the maxilla and palate bone. After resection, the surgeon checked
with the pointer if the resection corresponded with the pre-operative planned margins. A detailed
step-by-step protocol of the navigation steps in Slicer developed during this research is found in
Appendix A2 and is python scripted for automatization (Appendix B2).

2.2.8 Post-operative analysis

After the clinical fit of the CAD/CAM designs, the defect was obturated with the conventional putty
[SO. During the first follow-up visits (T=0), the conventional obturator was removed for volume
reduction and polishing by the prosthodontist. After removal, the 10Ss were weighted and
scanned using the TRIOS 3Shape. To investigate the amount of putty volume reduction, the
obturator of P1 was scanned again after 7 weeks (T=7) and registered using FPR to the original
sized putty obturator (T=0). The comparison of the putty reduction was made by using colored
coded distance maps between the two intraoral scans.

The weights (W) in grams (g) of the digital obturators were calculated by obtaining the
digital volumes (V) in Slicer, multiplied by the densities (p) of the denture reline (putty & tissue
conditioner) and Clear resin. The densities of the materials (see Table 2.1) were based on clinical
experiments throughout this research.

Table 2.1. Densities of the denture reline/ resin materials.

Material Density (g/cm3)
Putty 1.43
Clear 1.19
Tissue conditioner 1.00

The weight calculations of the digital and conventional obturators were followed by the
equations below. The reline material for the conventional ISO included the regular used Putty (Eq.
1). The CSM obturator includes a 2mm hollow inner shell of printed Clear resin (Eq. 2), and a solid
outer shell of Tissue conditioner (TC) (Eq. 3). The total weight of the CSM obturator (Wesy otar ) IS
the sum of the inner- and outer shell (Eq. 4). For a visualized perspective, see Figure 1.6 and Figure
2.13.

The weight reduction (W,.,) was calculated by subtracting the weight of the solid putty
ISO (W;so) from the weight of the CSM obturator ( Wesy totar ) (EQ- 5). The weight reduction
percentage (%) was also calculated (Eqg. 6).

Wiso(9) = Pputty * Viso (D

Wesm inner (9) = Peiear * Vcsm inner (2)
Wesm outer (9) = (Viso — Vesmsotiay) * Pre 3)
Wesm totat (9) = Wesm inner + Wesm outer (4)
Wrea(9) = Wiso — Wesm total (5)

) — (WCSM total — WISO)

7/74 0,
red ( % WISO

x 100% (6)

UNIVERSITY i B}
OF TWENTE. LEEUWEN |<J;3:f_rj [T&=~




Clinical evaluation of the CSM obturator

" N
CSM

7

- 5
#
outer

Figure 2.13. Schematical overview of the inner and outer layer calculations of the closed
surface model (CSM) obturator. The upper panel visualizes that the outer layer is obtained by
subtracting the volume of the conventional obturator with the scaled solid CSM obturator. The
lower panel visualizes the summation of the inner and outer shells of the CSM design.

UNIVERSITY -

OF TWENTE LEEUWENH\éAEE frms

NEDERLANDS KANKER INSTITUUT



Clinical evaluation of the CSM obturator

2.3 Results

2.3.1 Patients
Baseline characteristics for the four included patients are shown in Table 2.1.

Table 2.2. Baseline parameters of included patients

Patient Type of .

No. Sex Age (Years) tumor Stage Site of tumor
1 Male 66 ScC T4NOMO Right

2 Female 53 PLGA T2NOMO Left

3 Male 43 ScC T2NOMO Left

4 Male 69 SCC T2NOMO Left

SCC = Squamous cell carcinoma; PLGA = Polymorphous low-grade adenocarcinoma.

2.3.2 Registration error

Figure 2.14 shows the result of the FRE in terms of the RMS (mm) of the four clinical cases and is
visualized by a distance map overlay of the segmented teeth with the I0S of the upper jaw. As seen
by the distance mapping, the overall error is 1 mm on the upper teeth. As seen by the RMS, the
error is the lowest for patients 2 and 3 at about £0.3mm. The RMS is highest for patient 4, which
is also showing the highest number of artifacts around the teeth, seen by the color variation. The
resolution of the CT in patient 1 is the lowest as seen by the sharpness and colors of the segmented
teeth.

P1 P2

RMS = 0.68

o
Distances (mm)

RMS = 0.28 RMS =0.77

Figure 2.14. Distance mapping of the registration error of the intraoral scan of the upper jaw
and segmented teeth of a CT scan for four patients (P). The root mean square (RMS) of each
case is given below the registered teeth in millimeters. Note the lower resolution of the
segmented CT of P1 and high amount of scattering of the CT of P4.
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2.3.3 Clinical evaluation

The outcome of all the CAD/CAM designed ISOs in Autodesk Meshmixer are found in Appendix D.
Images of the designs during the fitting in the patient’s mouth will be visualized in the following
section per patient.

Patient 1

Figure 2.15 shows the result of the OR images of the 3D printed hollow bulb design and the CSM
design around bone & soft tissue in three different scales. It can be seen from Figure 2.14 that the
lowest scale (0.6) and the hollow bulb had the most underestimated volume compared to the
maxillary defect. The CSM scaled to 0.7 indicated a better clinical fit. The volume of the CSM scaled
to 0.8 shows the best clinical fit except in the anterior direction, in which the obturator exceeded
the remaining alveolar bone.

Bone & soft tissue CSM

Figure 2.15. Image results of the clinical fitting of the digitally designed prostheses in patient
nr. 1, directly after partial resection of the maxilla. The designs included a closed surface model
(CSM) around the segmented resection bone and soft tissue in different scales, and a hollow
bulb A) CSM design scaled to 0.6. B) CSM design scaled to 0.7. C) CSM design scaled to 0.8. D)
Hollow bulb design.

Patient 2

Figure 2.16 shows the result of the OR images of the 3D printed hollow bulb design (A), intraoral
scanned obturator of a retrospective patient with similar resection margins (B), and four different
CSM designs around the bone & soft tissue (C-F). Table 2.3 and Table 2.4 below present the clinical
fitting scores from the designs scaled to 0.8 and 0.7 respectively. As can be seen from the tables,
the 0.8-scaled obturators showed a better clinical fit compared to the 0.7-scaled. The best scored
obturators (score = 4.5) were the 0.8 scaled CSM around the resection bone (D) and the 0.8 scaled
[0S scanned obturator (Figure 2.16 B) (score = 4). The worst clinical fit as seen by the scoring
tables and on the lateral side of the patient (C+F) were both the automatic bone and soft tissue
CSM obturators. The hollow bulb (A) showed an average clinical fit (score = 3) in all directions.
The manual CSM (E) showed a bad clinical fit, as seen also at the lateral side.
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Bone & soft tissue CSM

Manual CSM _.

Figure 2.16. Image results of the clinical fitting of the digitally designed prostheses in
patient nr. 2, directly after partial resection of the maxilla. The six designs included four
different closed surface model (CSM) around the segmented resection (bone) and soft tissue,
a hollow bulb, and a fitted intraoral scanned (10S) obturator. A) Hollow bulb design. B) 10S
of a similar resection. C) Automatic two combined CSM’s around bone and soft tissue. D)
Automatic CSM around bone. E) Manual selected fiducial points around bone and soft tissue.
F) Automatic CSM around bone and soft tissue.

Table 2.3. Clinical 0.8 scaled obturator fit in patient nr. 2 scored by prosthodontists.

Design Poor Bad Average Good Excellent

1 2 3 4 5

A X

B X

C X

D X X

E X

F X

A = Hollow bulb; B = intraoral scan obturator; C = Two combined bone & soft tissue closed surface
model (CSM); D= Bone CSM; E = Manual selected CSM; F = Bone & soft tissue CSM.
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Table 2.4. Clinical 0.7 scaled obturator fit in patient nr. 2, scored by prosthodontists.

Design Poor Bad Average Good Excellent
1 2 3 4 5

A X

B X

C X

D X X

E X

F X

A = Hollow bulb; B = intraoral scan obturator; C = Two combined bone & soft tissue closed surface
model (CSM); D= Bone CSM; E = Manual selected CSM; F = Bone & soft tissue CSM.

Patient 3

Figure 2.17 shows the result of the OR images of the 3D printed CSM around the resection bone in
different scales (A-C) and the hollow bulb design (D). Table 2.5 presents the clinical fitting score
results of this case. As shown by both the OR images and the scoring table, each of the CSM designs
had a good fit. (score =4). The models connected well with the surrounding tissue except for a
little overestimation in the most posterior-inferior corner of the prosthesis when the jaws were
enclosing. The differences between the CSM models as visualized in the images are the amount of
surrounding space which decreases for the larger scales. The hollow bulb fit scored less compared
to the CSM designs.

Bone CSM

Figure 2.17. Image results of the clinical fitting of the digitally designed prostheses in patient
nr. 3, directly after partial resection of the maxilla. The designs included a closed surface model
(CSM) around the segmented resection bone in different scales, and a hollow bulb A) CSM
design scaled to 0.7. B) CSM design scaled to 0.8. C) CSM design scaled to 1.0. D) Hollow bulb
design.
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Table 2.5 Clinical obturator fit in patient nr. 3 scored by prosthodontists.

Design Poor Bad Average Good Excellent
1 2 3 4 5
A X
B X
C X
D X X

A = Closed surface model (CSM), scale =0.7; B = CSM, scale = 0.8; C = CSM, scale = 1.0; D = Hollow
bulb.

Patient 4

Figure 2.18 shows the result of the OR images of the 3D printed CSM around the resection bone,
scaled to 0.8 (A-C) and 1.0 (D). The design of Figure 2.18 A show the additional zygoma wiring
bollard at the posterior side. The designs of Figure 2.18 B+C show the enlarged lateral width. Table
2.6 presents the clinical fitting score results of this case. All CSM designs had an overall average or
good fit (score = 3-4) with a slight overestimation on the medial side. The clinical fit of the bollard
itself was not scored. As seen by the scores and the OR images, the 0.8-scaled CSM design with an
additional 10 mm width, showed the best clinical fit (score =4).

Bone CSM

Figure 2.18. Image results of the clinical fitting of the digitally designed prostheses in patient
nr. 4, directly after partial resection of the maxilla. The designs included a closed surface model
(CSM) around the segmented resection bone in different scales and additional lateral width.
A) CSM design scaled to 0.8. with a zygoma wiring bollard B) CSM design scaled to 0.8 and
additional 5 mm width. C) CSM design scaled to 0.8 and additional 10 mm width D) CSM design
scaled to 1.0.
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Table 2.6 Clinical obturator fit in patient nr. 4 scored by prosthodontists.

Design Poor Bad Average Good Excellent
1 2 3 4 5
A X X
B X X
C X
D X
A = Closed surface model (CSM), scale =0.7; B = CSM, scale = 0.8; C = CSM, scale = 1.0; D = Hollow
bulb.

2.3.4 Post-operative analysis

Figure 2.19 shows the difference between the putty obturator of P1 directly after surgery (T=0),
and after 7 weeks (T=7) of refining and polishing during the post-operative visits. The intraoral
scanned obturator of TO is shown here in four views, the differences are visualized in colored
coded distance maps. As seen by the figure, the obturator was mainly reduced at the lateral and
posterior sides of the obturator for about 10 - 15 mm.

Putty reduction after follow-up visits

(7 weeks post-surgery)

Anterior Medial Posterior Lateral

-15 7,5 0.0 7,5 15
B Reduction Distances (mm) Increase .

Figure 2.19. Color-coded distance maps of the obturator of case 1, directly after surgery, and
after 7 weeks post-surgery in four directions. Note the amount of reduction at the lateral and
posterior side of the obturator.

Figure 2.20 shows the results of the best-fitting CSM obturators scaled to 0.8 (yellow),
with the registered intraoral scanned conventional ISOs as a transparent overlay. The figure
shows the models in the superior view (upper panel) and lateral view (lower panel). There was
no data available on patient 4, due to the patient’s death.

As seen in Figure 2.20, P1 shows the largest and widest obturator compared to the other
patients, in which the CSM shows an anterior overestimation and a posterior underestimation. P2
shows a wide conventional obturator across the septum midline, in which the CSM obturator
exceeds the obturator in the posterior direction. P3 has the smallest conventional obturator
volume, compared to the other patients. The CSM obturator of P3 shows the best fit inside the
contours in the superior view, with an overestimation in the posterior-inferior direction, as shown
in the lateral view of Figure 2.20.

UNIVERSITY —
OF TWENTE LEEUWENH\C/)LEE JIES -



Clinical evaluation of the CSM obturator

[no data]

[no data]

P1 P2 P3 P4

Figure 2.20. Digital closed surface model (CSM) obturators (yellow) with the registered
intraoral scanned conventional putty obturator (transparent overlay) per patient (P). The

upper panel visualizes the obturators in the superior view, and the lower panel in the lateral
view.

2.3.5 Weight reductions

Table 2.7 sums the results of the putty 10S (T=0) and CSM volumes in Slicer and the calculated
weight differences using the densities in Table 2.1. The results indicate a correlation between
volume and absolute weight reduction. P1 shows the largest conventional weight and volume, and
the highest absolute weight reduction. P3 shows the smallest conventional weight and volume,

and the smallest absolute weight reduction. The weight percentages for all patients are around =
36 —39%.

Table 2.7 Volume and weight reduction results of each clinical case.

Patient Volume Volume Volume Weight “Eesll%/[ht Weight Weight
No 10S CSM TC 10S total reduction reduction
' (cm3) (cm3) (cm3) (8) () (8) (%)
1 49.97 6.45 37.31 71.46 45.11 26.35 36.87
2 31.11 5.31 21.20 45.92 3211 18.33 39.92
3 14.06 3.06 8.40 20.10 12.06 8.04 39.99
4 - - - - - - -

CSM= Closed surface model; I0S = Intraoral scan of the conventional obturator.
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2.4 Discussion

In this clinical trial study, we examined the shape and clinical fit of novel CAD/CAM 3D printed
hollow ISOs in four maxillectomy patients, using intraoral scanning technology and CT to reduce
the weight of conventional ISOs. We compared different CSM designs, in which the 0.8 scaled
model around segmented resection margins showed the overall best clinical fit with a weight
reduction between 36 - 39%.

2.4.1. Interpretation of results
The following section will discuss the different obturator designs for each case, starting with the
first patient.

For the first patient, we included both skin and bone in the design to gain more obturator
volume, because the conventional ISO is often larger than the defect to prevent sunken cheeks.
The skin involvement resulted, however, in an anterior overestimation, exceeding the alveolar
bone. Although the design was still considered clinically implementable by the prosthodontist,
closing the mouth would be difficult and would look aesthetically unpleasant due to the tight skin
around the lip. On the other hand, sufficient surrounding space was visible at the lateral and
posterior sides. This result may be explained by the fact that the cheek is widened and thickened
here compared to the anterior side. The 0.6 scaled CSM design had an overall volume
underestimation and was, therefore, excluded from the designs in the other three patients.

For the second patient, more pre-operative time was available, which enabled more
different designs. For a better assessment, we added the clinical scoring table. Based on the
previous results, the CSM designs did not include soft tissue anterior to the resection bone. The
bone CSM design without soft tissue involvement showed the best clinical fit, contrary to the
expectations based on the wide obturator from the previous case. The reason is likely due to the
less surgically removed teeth (3), which results in less space for the obturator to fit along the
remaining teeth. A wide obturator would not pass the teeth, which explains why the bone CSM
design had the best fit. Surprisingly, compared to the conventional ISO (Figure 18), the design had
a noticeable posterior overestimation, but this did not affect the clinical fit. A possible explanation
could be that the conventional ISO is naturally shaped by the surrounding soft tissue towards the
medial side during placement. This shape characteristic is also visible in the other scans of Figure
18.

Moving on to how to consider the IOS obturator design of another research case,
although the I0S design showed one of the higher scores, it would not be usable in patients with
another resection type. Finally, the manual-designed obturator was not further used because it
would not contribute to an optimized workflow. Besides, it had a lower clinical fitting score.

The third patient had the same type of resection (three molars, height of alveolar bone)
as the second patient. The difference between them was the size of the palate involvement, which
was significantly smaller for this case resulting in a small volume of putty compared to the
previous two cases. Based on the results of the previous patient, we expected that bone CSM
designs without including soft tissue would have the best clinical fit. Although the different CSM
scales scored evenly (=4), the 1.0 scaled obturator had hardly any free surrounding space for
additional relining material. As a result, it would not make post-operative volume adjustments
possible. As seen from the obturator overlays (Figure 18), the CSM obturator exceeds the
baseplate, which troubled the enclosing of the jaws. The posterior-inferior overestimation
indicates the importance that the obturator needs to follow the natural shape of the palate parallel
to the baseplate.

For the fourth patient, the previously studied hollow bulb was not considered, because it
scored less well, as expected, in all three previous cases. The resection type was comparable to
the first patient (molars - canine, the height of alveolar bone). Consequently, a wider obturator
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shape was expected, and thus both the resection bone and soft tissue would initially be included
in the design. The amount of CT scatter (Figure), however, made it challenging to distinguish the
soft tissue during the segmentations. For this reason, soft tissue was not included, but the bone
designs were enlarged instead at the lateral side to gain more volume. As expected, the enlarged
volumes had the best clinical fit. Yet, none of the designs were excellent because of a tight fit
against the nasal septum. Safety margins would have prevented this outcome.

One of the issues that emerged from these clinical findings is that the volume and width
of the obturator highly depend on the resection type and the number of resected teeth.
Furthermore, the post-operative weight calculation findings indicated a correlation between
volume and absolute weight reduction. On the contrary, the weight reduction percentage was
almost equal in all patients. The weight reduction never exceeded 40% due to the design
limitations and the weight contribution of the resin and tissue conditioner. Nevertheless, this
amount of weight reduction exceeded the maximum expected 33%, as stated by Dalkiz et al., 2018.
Moreover, the post-operative findings showed a significant reduction in obturator size in the
lateral and posterior direction (10 - 15 mm). This result indicated the need for scaling of the
CAD/CAM design to allow the prosthodontist to alternate the design during the follow-up visits.

2.4.2 Strength and weaknesses

The study had multiple limitations. First, there were limitations regarding the population group.
The research cohort is relatively small due to the low incidence of maxillectomy patients each year
in the NKI-AVL. Another drawback was that the patient’s comfort after the actual implementation
of the obturator was not researched. Nevertheless, it should be considered that this was a trial-
and-error clinical study, and a small patient cohort is often seen in similar clinical case studies in
this field [1], [57]. On the other hand, despite this small cohort, this is the largest clinical trial
cohort yet in this field to research CAD/CAM designed ISOs. This study alone gained much
information about the shape and sizes of ISOs in general since it lacks in literature. Future
collaborations with other hospitals could enlarge the cohort.

Second, there were limitations regarding the accuracy of the CT images involving the
registration error. The PET-CT scan of patient 1 had a spacing between slices of 1.17 mm and a
slice thickness of 2.0 mm, which affected the resolution of the segmentations. For this reason, it
made it more difficult to find distinctive characteristics of the teeth, resulting in a higher RMS
value. In addition, the scatter of the fourth patient also resulted in a higher RMS value due to the
artificial teeth. On the other hand, the RMS of all patients was <1mm, which suggests that the FPR
method is valid and would have had limited influence on the clinical fit. Another drawback that
highly affects the clinical fit, was that the pre-and- postoperative resection margin variability was
not measured. Yet, we assumed that using the virtual surgical planned Fusion ENT navigation
system would have improved the clinical fit. Also, research has stated that this navigation system
results in a higher accuracy of surgical procedures [58].

Third, the study had limitations regarding the precision of the resection margin contours.
Only one observer defined these contours. Nevertheless, the shape of the CSM alters with the
varying resection margins contours, and therefore the observer does not affect the clinical fit.
Furthermore, there was an intra-observer variation by a learning curve in the design choices for
each patient. The learning curve is an essential issue for future research. Additionally, there was
an intra-observer variation in the clinical fit scoring of the obturators by the prosthodontist.

Fourth, the registration steps of the digital NKI-AVL workflow were limited to dentate
patients. The registration steps can be alternated for edentate patients. For example, the study of
Deferm et al. (2022) used a soft tissue-based registration algorithm to register 10S and CT scans
[59]. However, a drawback of this algorithm is the need for a high-resolution (CB)CT scan. Another
solution for the future inclusion of edentate patients could be with registered marker points on
dentures while scanning. Furthermore, the digital NKI-AVL workflow is not fully automated yet,
despite the fewer (manual) steps. For instance, the encoded Slicer steps (Appendix B1 and B2)
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could be integrated into a user interface. For reproductive purposes, the protocols of Appendix A1l
and A2 should provide additional clarity for future (non-technical) users.

Finally, the different scales used for the CSM design were based on trial-and-error and
thus not according to the literature. Previous studies in this field only focused on the clinical fit
immediately at surgery and did not take the post-operative adjustments of the ISO into account.
For example, the study by Kortes et al. (2018) researched a 3D ISO for a clinical case based on CT
and MRI. They re-printed a new interim obturator for the first follow-up visit, which is not time
and cost-effective [1]. In addition, compared to their innovative method, in which they used the
tumor contour verification (and its margins) for the obturator design, the current CSM workflow
seems faster, easier, and more automated.

2.4.3. Future recommendations

Several questions remain unanswered at present. The patient’s comfort after implementing the
digital hollow-designed ISOs should be researched in future, larger cohort, clinical studies. It is
recommended to implement the conventional ISO for the control group. In addition, we suggest a
study that focuses on the impact of weight reduction differences experienced by a patient at
different CAD/CAM design scales (e.g., 0.7, 0.8). The importance lies in the patient’s comfort rather
than researching the exact shape or scale of the obturator design. Also, the feasibility of small
maxillary defects regarding the patient’s comfort, time, and cost-effectiveness of obturators,
should be researched.

Further work is required to establish the final clinical implementation. The baseplate
needs holes for the teeth retention wires together with a well-designed boulder for larger type
defects. In addition, to gain retention and stability in large complex maxillary defects, a 3D
zygomatic implant-supported prosthesis could be considered in future designs [60]. Furthermore,
investigating the safety margins, especially for the nasal septum and the lower jaw movements, is
important to improve the clinical fit in future research. In addition, enlarging the CSM obturator
in the lateral direction could be a solution for CTs with scatter or larger (>1mm) slice thickness.
Also, this design choice could be an improved substitute for the CSM model around the bone and
soft tissue, which should be researched.

In terms of the digital workflow, creating a (partly) automated user interface would ease
the steps for (non-technical) users. Finally, future research should also measure the pre-and
postoperative resection margin variability using the in-house Fusion ENT navigation system.
Future research should also consider using a more advanced type of surgical navigation to reduce
the variability or may use surgically navigated cutting guides.

2.5 Conclusion

The purpose of the current clinical-trial study was to evaluate the digital hollow CSM design and
to improve the existing NKI-AVL concept CAD/CAM workflow.

Taken together, our findings suggested a promising prospect for using this automatic
CSM approach when comparing the existing hollow bulb obturator design. Based on the results,
it is expected that a CSM scale around 0.8 could be a good balance between obtaining weight
reduction, clinical fit, and post-operative usability. Furthermore, these findings may help us to
understand how the resection type influences the shape and, therefore, the clinical fit of the ISO.
We thus recommend predicting the obturator shape based on the resection margins in future
research.

Further improvement of the baseplate design is required for clinical implementation of the
digital ISO workflow by including retention wire holes and a boulder. In addition, the workflow
should be more automated and include safety margins in the obturator design.
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3. Retrospective study:
verification of the CSM
obturator

3.1. Introduction

A clinically relevant finding of the study described in chapter 2 was that the shape of the ISO varies
and highly depends on the maxillary defect. The varying obturators make it difficult to predict and
design the final CAD/CAM shape. Compared to literature, no research on obturator shapes has
been reported yet, to our knowledge. Nevertheless, many maxillectomy classification systems
exist, such as Brown’s (see chapter 1.8). These classification systems, however, are used for
maxillectomy planning and do not provide knowledge about obturator shapes. Although those
classification systems can provide guidance, the shape of the ISO is determined by more factors
than the bony resection alone. From our clinical experience, the ISO is shaped and supported by
surrounding hard- and soft tissue and depends on the resection height and number of resected
teeth. For example, as indicated in the previous clinical study, resecting the canines is an
important factor in whether the obturator is enlarged at the lateral side. Consequently, this
obturator variation depending on resection type needs to be considered in future CSM designs.
To obtain a supporting tool to classify and predict the surgical obturator shape to standardize the
CSM designs, and to gain a more user-friendly workflow, we developed a novel classification
system.

The classification system is called: the Ooms’ ISO classification system based on the
maxillary defect. The classification system is based on our clinical experiences, and expert
knowledge, and is inspired by existing maxillary classification systems. The following paragraphs
explain which factors contribute to the shape of the ISO, separated into horizontal and vertical
components.

3.1.1. Horizontal components

From an axial point of view, the shape of the ISO can be divided into four components, which are
schematically shown in Figure 3.2. The first component (red), the medial side, is the preoperatively
determined palatal resection margin perpendicular to the nasal septum. The remaining part of the
palate and the nasal structures, such as the septum, concha, and cartilage, cause a straight vertical
line at the medial side of the ISO. The second component is the oblique preoperatively determined
palatal resection margin, directed to the most anterior resected tooth.

The third component points to the lateral direction. The size and angle depend on the
vertical resected location on the basal arch of the maxilla. This component is shaped by
surrounding soft tissue such as the cheek and therefore follows its anatomical direction. A large
defect allows vertical and wide horizontal expansion of the ISO, resulting in increased pressure
against the cheek. The third component tends to be significantly narrower in small posterior
defects where for example only the molars are resected. The narrow shape is also due to the
essential point that a large ISO will not fit through the mouth in this example. Figure 3.1 highlights
the comparison of the second and third components of two intraoral scanned ISOs, along with a
schematically drawing of teeth. In the case of the narrow obturator (yellow), only the molars are
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resected, while in the wide obturator (purple), the resection also includes the premolars and the
canine.

ol L-

Figure 3.2. The four horizontal direction components of the immediate surgical obturator.
1) Vertical resection component. 2) Oblique resection component. 3) Lateral component
following the direction of the cheek. 4) Medial component shaped by the buccal and
masticator space.
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Figure 3.1. Comparison of two intraoral scanned immediate surgical obturators (ISO’s) with
the direction of the ISO’s pointed out by the oblique surgical resection margin (blue line) and
its lateral outer direction (green arrow). Note that in case of the purple ISO, three more teeth
are resected and therefore the green direction arrow is wider and larger.

Finally, the fourth component follows a medial direction due to the surrounding soft tissue
(see yellow arrow Figure 3.1). To illustrate these surrounding structures, Figure 3.3 shows two
axial MRI slices of the upper jaw with highlighted soft tissue spaces. An essential structure, for
example, is the buccal space (orange) which contains the buccal fat pad (BFP), also-called Bichat's
fat pad. The BFP consists of the main body located at the posterior maxilla with four extension
lobes. The contour of the cheeks is mainly determined by the buccal extension of the BFP. Recently,
the BFP is occasionally used to enclose postsurgical maxillary defects [61]. Another important
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surrounding structure is the masticator space (green), which includes the mastication muscles
and the posterior mandible [62].

Current Current

Masticator Space Ml

Figure 3.3. MRI slices of the upper jaw (axial view) with highlighted surrounding soft tissue:
buccal space (orange) and masticator space (green). The lateral and medial directions of the
immediate surgical obturator are marked by a green and yellow arrow, respectively.

3.1.2. Vertical components

Besides the horizontal components, the size and shape of the ISO depends on the height of the
resection. Table 3.1 and Figure 3.4 present the cephalometric landmarks contributing to the
classification system [63], [64].

Table 3.1 List of anatomical landmarks in the maxillofacial region.

Landmarks Definition
Canine eminence (Ce) Maxilla surface point corresponding to the canine root apex
Zygomaxillare (Zm) Most inferior point of the zygomaticomaxillary suture
Zygoorbitale (Zo) Most superior point of the zygomaticomaxillary suture
Zo
Zm
Ce
—— = @

Figure 3.4: The maxillary cephalometric landmarks of the Ooms’ classification
system in anterior view.
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The zygoma arch is an essential factor because it mainly shapes the facial structure and
aesthetics, in which the ISO replaces these important bone structures. For this reason, it is
necessary to divide whether the resection involves the alveolar bone or exceeds the Zygomaxillare
(Zm), with its maximum to the orbital floor (Zo). Alongside the maxillary heights, the figure shows
another landmark, the canine eminence (Ce). This landmark separates the anterior (incisors) and
posterior (molars) maxillary arch. The Ce landmark is used as a border for the classification
system to state whether the conventional obturator expands horizontally to the cheeks as
explained in the previous section.

3.1.3. Classification system

Based on the previously explained horizontal and vertical components, Figure 3.5 illustrates the
seven categories of the Ooms’ ISO classification for unilateral maxillectomy resections. The system
defines whether the horizontal resection is below or above the Zm landmark, which is defined
here as alveolar (A) and zygoma (Z) respectively. The vertical axes define if the resection is medial
(I), intersects (II), or is lateral to the Ce landmark (III). The fourth vertical category (IV) involves
the resection of the whole unilateral maxilla. Examples of classified conventional ISOs used to
develop the classification system are visualized in Appendix E

| 11 111 IV

Alveolar

(A)

Zygoma
(Z)

Figure 3.5. Ooms’ immediate surgical obturator classification system based on the unilateral
maxillary defect. Each class is horizontally divided into the height of the resection: alveolar
(A) and or zygoma (Z). Vertically, the classes are divided into the frontal arch (I), and
whether the canine eminence is resected (II) or not (III). The fourth category (IV) involves
the resection of the whole unilateral maxilla.

Table 3.2 explains how the resection margins affect the shape of the CAD/CAM obturator
design and whether soft tissue is involved besides the segmented bone. For a visualized
perspective, see Appendix F.
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Table 3.2. Ooms’ immediate surgical obturator classification.

Alveolar

Class

Class II

Class III

Class IV

The horizontal maxillary resection involves the alveolar bone, and the vertical
resection is located medial from the canine eminences. The obturator remains small
and never exceeds the bony resection margins because of the tight skin around the
lip. Therefore, only the resection bone is considered in the ISO design. The
maximum height is limited to the nasal spine.

Macxilla resection involves the alveolar bone horizontally and intersects the canine
eminence vertically. The resection results in additional space for a wide-shaped ISO.
The obturator exceeds the bony resection margins mainly at the lateral side, adding
more pressure to the surrounding soft tissue. Therefore, both the resection bones
and the m. Buccinator are considered in the ISO design. The height of the ISO is
limited to the horizontal resection margin.

The horizontal maxillary resection involves the alveolar bone, and the vertical
resection is located lateral from the canine eminences. The obturator consequently
remains narrow, slightly exceeding the bony resection margins. Therefore, only the
resection bone is considered in the ISO design. The height of the ISO is limited to the
horizontal resection margin.

The horizontal maxillary resection involves the alveolar bone, and the vertical
resection is located both medial and lateral from the canine eminences. The
resection results in a combination of classes A-I and A-II.

Zygoma

Class II

Class III

Class IV

The horizontal maxillary resection involves the alveolar bone and exceeds the
inferior zygomaxillare suture. The vertical resection intersects the canine eminence.
The large width and height of the resection, result in a tall and wide ISO, finding its
support in the cheeks. Therefore, both the resection bone and the buccal fat pad are
considered in the ISO design. The height is limited to the horizontal resection with
its maximum at the orbital floor.

The horizontal maxillary resection involves the alveolar bone and exceeds the
inferior zygomaxillare suture. The vertical resection is located laterally from the
canine eminence. The ISO is narrow and tall, slightly exceeding the contours of the
bony resection. Therefore, only the resection bone is considered in the ISO design.
The height is limited to the horizontal resection with its maximum at the orbital
floor.

The horizontal maxillary resection involves the alveolar bone and exceeds the
inferior zygomaxillare suture. The vertical resection is located both medial and
lateral from the canine eminences. Therefore, the design results in a combination of
classes A-I and Z-1I.

3.1.4. Study aim

This research is a retrospective study that aims to validate the CSM design based on the Ooms’ ISO
classification system. It is thus expected that the CSM design needs to be enlarged around
surrounding soft tissue for classes A-II, A-1V, Z-II, and Z-IV according to Table 3.2. These
statements will be validated by comparing the shape, volume, and weight reduction of the CSM
designs with segmented conventional ISOs from post-operative CT scans.
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3.2. Methods

3.2.1. Patients

The retrospective study included patients who underwent a maxillectomy between 2009 - and
2020 in the AVL - NKI hospital. The criteria included that both a pre-and postoperative CT scan
were available for each patient. In addition, the conventional bulb could be distinguished in
grayscale and therefore segmented from the postoperative CT scan. This inclusion left 17 patients
who were enrolled in the study (Figure 3.6).

Maxilla resection
hard palate
Between 2009-2020
(n=110)
Excluded (n=10)
No pre-or postoperative CT
n=100
Excluded (n=83)
The conventional bulb could
not be segmented on
postoperative imaging data.
Enrolled
(n=17)

Figure 3.6. Inclusion criteria for maxillectomy patients in the Antoni van Leeuwenhoek
hospital - National Cancer Institute.

3.2.2. CT analyses

Patients underwent CT scanning with a reconstructed slice thickness of 0.5-5.0 mm. All CT scans
were made at the NKI-AVL using the same CT scanner and settings. All scans were performed with
120 kVp and exposure 18-300 mA. The field of view was 512x512 pixels and pixel spacing varied
between 0.24 x 0.24 mm and 1.17 x 1.17 mm. The CT dose index (CTDIlva) was 1.97-29.39 mGy
and the dose length product was 70-1039 mGy*cm.

3.2.3. Technical analysis

The open-source software Slicer was used for semi-automatic greyscale thresholding of the skulls.
The maxillary resection margins were obtained by registration (FPR) and subtraction of the
segmented post- and pre-operative skulls (Figure 3.7). The conventional obturator was segmented
from the postoperative scan.

All the resection margins were classified using the Ooms’ classification system. The
bilateral cases were considered as class A-IV or Z-IV. The CAD/CAM CSM obturators were
automatically designed from the maxillary pre-operative resection margins using the Slicer
extension ‘Markups to Model’ (see Figure 2.2). For Ooms’ classification classes A-II, A-1V, Z-11, and
Z-1V, additional 3D models were designed from both the resection margins and the surrounding
soft tissue. This resulted in 3D-designed ‘bone CSMs’ and ‘bone & soft tissue CSMs'".
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Conventional
obturator
Registration
—
Resection
margins
Pre-operative CT Post-operative CT » (post - pre CT)

Figure 3.7. Workflow to obtain the segmented conventional obturator and resection margins.
First, the pre-operative CT is registered to the post-operative CT. Next the conventional
obturator is segmented from the post-operative scan, and the resection margins are obtained
by subtraction of the skulls.

Both the CSMs and conventional ISOs (Figure 3.8 A) were then exported and saved as a
STL file format. The STL models were imported into the open-source-3D-modeling software
Meshmixer. The CSM designs were scaled to 0.8, based on the clinical results of Chapter 2, and
made hollow with a 2Zmm thick edge of Clear resin. On top of the Clear resin, an outer layer of TC
was considered (Figure 3.8 B).

Two additional theoretical reference obturators were designed, by transforming the solid
conventional obturator (Figure 3.8 A) into a hollow model with a 2mm thick edge Clear resin. The
first reference model, without an outer layer of TC, was referred to as the Theoretical Maximum
Reference (TMR) (Figure 3.8 C). For a more clinically feasible comparison, the second reference
model was scaled to 0.8 to contain an additional layer of TC, referred to as the Theoretical Clinical
Reference (TCR) (Figure 3.8 D). The different hollow obturator volumes (Figure 3.8 B-D) were
compared to the conventional solid putty obturator volumes (Figure 3.8 A).

The weights (W) of the digital obturators were calculated by obtaining the digital volumes
(V) in Slicer, multiplied by the density (p) of the denture reline (putty and TC) materials and Clear
resin. The absolute and percentage weight reductions of the TMR, TCR, and CSM design, compared
to the segmented conventional obturator, were calculated according to the methods described in
Chapter 2.2.7.
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B
Conventional Putty CAD/CAM
Obturator Closed Surface Model
(Scale = 0.8)
C D
Theoretical Maximum Theoretical Clinical
Reference Reference
(Scale =1.0) (Scale = 0.8)

Figure 3.8. Schematic overview of the different obturator designs. A) Conventional putty
obturator. B) Computer aided- and designed (CAD/CAM) closed surface model (CSM) design,
scaled to 0.8 with a layer of tissue conditioner (TC). C) Theoretical Maximum Reference:
hollow 2mm thick Clear resin conventional obturator. D) Theoretical Clinical Reference:
hollow 2mm thick Clear resin conventional obturator scaled to 0.8, with a layer of TC.

The shape and volume comparison between the conventional obturator and CSM design
was assessed in Slicer by one of the most used overlap-based segmentation metrics: the Hausdorff
Distance (HD) [65]. The HD calculates the largest distance (d) between point set X (CSM obturator)
to Y (conventional obturator) as schematically visualized in Figure 3.9 [66]. Furthermore, the 95t
percentile (95%) HD was calculated, which is the maximum HD without outliers. In addition, the
average HD was calculated, which takes the average of all distances (d) between the point sets
[67]. For an additional virtual comparison, the distances from the CSM design to the conventional
ISO (dyy) were saved as colored-coded distance maps and projected on the conventional ISOs.
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Figure 3.9. Schematic overview of the Hausdorff Distance [66].

3.2.4. Statistical methods

Descriptive statistical analyses were performed using IBM SPSS version 28 (IBM Corp., Armonk,
NY, USA). These analyses included correlation calculations between weight reduction and volume
using Pearson’s product-moment correlation coefficient (r) for a significant p-value <0.01. In

addition, boxplots were made to summarize the minimum, maximum, mean values, and standard
deviations of the HDs and obturator volumes.
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3.3. Results

3.3.1 Patients
Baseline characteristics for the seventeen included patients are shown in Table 3.3.

Table 3.3. Baseline parameters of included patients.

Time post-

Case Ooms’ Type of Tumor Site of Bilateral operative

No. class tumor stage tumor resection S on after
surgery
(days)

1 Z-111 oM cT4NOMO Left No 4

2 Z-1V SCC cT4NOMO Left No 63

3 A-111 AdCC cT4NOMO Left No 27

4 Z-11 SCC cT4NOMO Right No 92

5 Z-1V SCC cT3NOMx Left No 46

6 Z-1V ScC cT4NOMx Left No 31

7 A-111 ScC cT4NOMO Right No 273

8 Z-11 SCC cT4NOMO Right No 43

9 Z-11 SCC cT4NOMO Left No 32

10 Z-1V AdCC cT2NOMO Left No 78

11 A-IV SCC cT4NOMO Right No 75

12 Z-1V SCC cT4NOMO Right No 25

13 Z-1V ScC cT4NOMO Right No 72

14 Z-1V ScC cT4NOMO Left No 28

15 A-IV AdCC cT4NOMO Right Yes 50

16 Z-1V ScC cT4NOMO Left Yes 25

17 A-11 SCC cT4NOMO Right No 31

SCC = Squamous cell carcinoma; AdCC = Adenoid cystic carcinoma; OM = Odontogenic mycoma.

Table 3.4 presents a summary of the number of patients with a designed ‘bone CSM’ and with an
additional ‘bone & soft tissue CSM". The table is also divided by uni-and lateral resection margins.

Table 3.4. Summary of the number of patients per CSM type.

Definition Number
Uni- and bilateral bone CSM 17

Uni- and bilateral bone- and soft tissue CSM 11
Unilateral bone CSM 15
Unilateral bone- and soft tissue CSM 9

CSM = Closed Surface Model.

3.3.2 Weight reduction

Table 3.5 presents the summary of the weight reduction results of the TMR, TCR, and bone CSM
obturator, compared to segmented conventional obturators of seventeen uni-and bilateral cases.
The direct comparison is shown in Table G1 of Appendix G. The weight reduction values include
the minimum, maximum, mean values, and standard deviations. This table shows that the highest
weight reduction is achieved by the TMR obturator, with an absolute reduction of 60g and a
percentage reduction of 69%. The TCR and CSM both have a mean absolute reduction of 40g and
percentage reduction of 47%.
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Table 3.5. Summary of the weight reduction results, presenting minimum (min),
maximum (max), mean () values, and standard deviations (o) for n=17.

TMR TCR CSM
Weight Weight Weight Weight Weight Weight
reduction reduction reduction reduction reduction reduction
(8) (%) (8) (%) (8) (%)
Min 28.8 55.5 19.4 37.1 15.7 34.5
Max 207.2 82.3 137.4 54.6 99.2 59.9

u*o 60.4+43.1 69.7+6.9 40.3+28.6 46.6+4.6 39.6+£21.8 47.0£6.5

TMR = Theoretical Maximum Reference; TCR = Theoretical Clinical Reference; CSM = Closed
Surface Model.

Table 3.6 shows similar weight reduction results as Table 3.5, without the two bilateral
cases (n=15). Compared to Table 3.5, this table shows that the minimum values are identical and

the maximum absolute weight reduction values are lower. The mean weight reduction
percentages differ <1%.

Table 3.6. Summary of the weight reduction results, presenting minimum (min),
maximum (max), mean (p) values, and standard deviations (o) for n=15.

TMR TCR CSM
Weight Weight Weight Weight Weight Weight
reduction reduction reduction reduction reduction reduction
(8) (%) (8) (%) (8) (%)
Min 28.8 55.5 19.4 37.1 15.7 34.5
Max 87.4 76.0 58.2 50.8 59.9 59.9

uto 48.4+18.7 68.7£6.5 32.4+12.4 45.9+4.4 34.3+15.1 47.6+6.6

TMR = Theoretical Maximum Reference; TCR = Theoretical Clinical Reference; CSM = Closed
Surface Model.

Figure 3.10 shows the correlation between the weight reduction and different volume
scales of the CSM obturator (i.e., the higher the scale, the less use of tissue conditioner) of patient
number 1. Both graphs show that the weight reduction is exponentially growing for increasing
volume scales. The maximum weight reduction percentage, the TMR, is 70%.

Absolute weight reduction and volume scale  Weight reduction percentage and volume scale

a5 Patient 1 0 Patient 1 TMR
TMR
T340 S
= = 007
© 35r¢ kS
© ©
< 30 S 50
S TC © TC
5 a7
i@ 25 [ ,.a” %D
) . = 40 -
=20 = o
_——
15 : ‘ ‘ ‘ ‘ ‘ 300 ‘ ‘ : ‘ ‘
0.4 0.5 0.6 0.7 0.8 0.9 1 0.4 0.5 0.6 0.7 0.8 0.9 1
Volume scale CSM obturator A Volume scale CSM obturator B

Figure 3.10. Correlation between the 2Zmm Clear resin volume scale of the closed surface
model (CSM) obturator and weight reduction of one clinical case. A) The absolute weight
reduction. B) The weight reduction percentage.
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Figure 3.11 shows the Pearson’s correlation results between the absolute weight
reduction and conventional obturator volume for (A) seventeen uni-and bilateral and (B) fifteen
unilateral cases. The plots show the TMR (blue), TCR (yellow), and CSM (red) obturator. All the
correlation plots show a strong relationship and are statistically significant for p <.001. As seen
from the graphs, all directions are positive (i.e., a greater volume is associated with greater weight
reduction). What stands out in Figure 3.11 A is the outlier, which has the largest volume and
weight reduction for all three plots. Furthermore, Figure 3.11 shows that the values of the TCR
and CSM obturators are more similar compared to the TMR, which has the overall highest weight
reduction values.

Figure 3.12 shows similar correlation plots as Figure 3.11, presenting the Pearson’s
correlation results between the weight reduction percentages and conventional obturator
volumes. All the correlation plots show a weak Pearson’s relation and are not significant. The plots
are in a horizontal direction, all TMR values are around 70% and are 40-50 % for the TCR and
CSM. Similarly, as Figure 3.11, the bilateral cases resulted in outliers and were excluded for the
remaining figures of this section.
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Correlation scatterplot of weight reduction and volume
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Figure 3.11. Pearson’s correlation scatterplots of the segmented conventional obturator volume and absolute weight reduction seventeen uni- and
bilateral (A) and fifteen unilateral (B) obturators. The plots present the differences between the computer-aided and designed (CAD/CAM) closed surface
model (CSM) obturator, the theoretical maximum reference: conventional volume (hollow), and the clinical reference: 0.8 scaled conventional volume
(hollow) with a layer of TC. Note the outlier differences between the two graphs and the similar positive trend of the different variables.
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Figure 3.12. Pearson’s correlation scatterplots of the segmented conventional obturator volume and weight reduction percentage of seventeen uni- and
bilateral (A) and fifteen unilateral (B) obturators. The plots present the differences between the computer-aided and designed (CAD/CAM) closed surface
model (CSM) obturator, the theoretical maximum reference: conventional volume (hollow), and the clinical reference: 0.8 scaled conventional volume
(hollow) with a layer of TC. Note the maximum weight reduction around 70% and the other designs around 40-50%.
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3.3.3 Shape & volume comparison

Table 3.7 presents the summary of the obturator volumes and the HDs between the fifteen
unilateral conventional obturators and the 0.8 scaled bone-CSM designs. The direct comparison is
shown in Figure G2 (Appendix G). As seen from the table, the minimum and maximum volumes of
the CSM obturators are significantly less than the conventional obturators. The average HD is
about 2 mm, which is considered to be the average overestimation. The maximum 95% HD value
is around 9 mm, which is about twice as small as the maximum HD (16 mm) since it includes
outliers. The minimum HD values are 0 mm, which indicates there are CSM designs without a
shape overestimation.

Table 3.7. Summary of the obturator volumes and Hausdorff Distances, presenting
minimum (min), maximum (max), mean () values, and standard deviation (c) for n=15.

Obturator volumes (cm3) Conventional vs. CSM 0.8 (mm)
. HD HD 95th
Conventional Bone-CSM . HD Average .
Maximum percentile
Min 29.1 55 0 0 0
Max 81.1 45.2 16.2 1.8 8.7
u*o 49.5+18.6 22.6x11.6 7.9+4.5 0.6x0.5 3.5%£2.6

HD: Hausdorff Distance; CSM = Closed Surface Model.

Table 3.8 presents the summary of the obturator volumes and the HDs between the nine
unilateral conventional obturators and the 0.8 scaled bone and soft tissue-CSM designs. The direct
comparison is shown in Figure G3 (Appendix G). Compared to the results of Table 3.7, the bone &
soft tissue-CSM designs had a larger shape overestimation, which is seen especially in the average
HD values in this table. In addition, none of the minima are equal to zero, indicating that every
CSM design shape is overestimated.

Table 3.8. Summary of the obturator volumes and Hausdorff Distances, presenting
minimum (min), maximum (max), mean (p) values, and standard deviation (o) for n=9.

Obturator volumes (cm?3) Conventional vs. CSM 0.8 (mm)
Conventional Bone & soft HD HD Average HD 95%
tissue-CSM Maximum percentile
Min 29.3 22.0 12.0 0.9 5.1
Max 81.1 61.0 17.5 2.8 9.9
uxo 58.3+19.3 42.1+13.8 15.0+1.8 1.8+0.6 8.1+1.6

HD: Hausdorff Distance; CSM = Closed Surface Model.

Figure 3.14 shows the boxplots of the HD results from Table 3.7 and Table 3.8 respectively.
As seen by the plots, the maximum (95 %) HD values have a wider range in the bone-CSM
compared to the bone & soft tissue-CSM. All mean HD values of the boxplots in Figure 3.14 B are
larger compared to Figure 3.14 A.

Figure 3.13 compares the conventional obturator volumes of each Ooms’ classification
class. Figure 3.13 A compares the alveolar and zygoma classes, and Figure 3.13 B compares all
classes. As seen in the Figure, the mean volumes of the zygoma classes are larger than the alveolar
classes. Class Z-1V has the highest mean volume and A-II has the lowest. The research cohort
consists of only one case for the classes A-II, A-IV, and Z-111, and none of the cases are A-I.
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Figure 3.14. Boxplots of the maximum, average, and maximum 95t percentile Hausdorff
Distances (HD) between the unilateral conventional obturator and the closed surface model
(CSM) designs. A) Bone-CSM designs. B) Bone & soft tissue- CSM designs. Note that the mean
HD values are higher in the right panel (B) compared to the left panel (A).
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Figure 3.13. Comparison of the volumes of the unilateral conventional obturators per class of
the Ooms’ classification system. A) Alveolar and zygoma class comparison. B) All classes

included.

Figure 3.15 shows the segmented skull, the bone-CSM design, and the conventional
obturator in different views with a colored-coded distance map overlay of two cases. The colors
indicate whether there is an overestimation (red) or underestimation (blue) of the CSM shape
compared to the conventional obturator. As seen by the blue colors in Figure 3.15 A, the CSM shape
was mostly underestimated except for 1-2mm at the medial side (nose septum). The CSM design
shape in Figure 3.15B indicates more overestimation (red), especially at the orbit as seen by the
anterior view. An overview of all cases for both the bone-CSM and bone & soft tissue-CSM designs
is shown in Appendix H1 and H2, respectively. Most of the bone & soft tissue-CSM designs are
overestimated in shape and volume as seen by the red areas.
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Figure 3.15. Two cases with their closed surface model (CSM) (yellow), designed from the
segmented resection bone, and the conventional obturator with a distance mapping overlay.
The overlay indicates the distance between the conventional and the CSM obturator (i.e.
red/negative distance is an overestimation and blue/positive distance is an underestimation).
A) Patient 1, classification Z-III. B) Patient 12, classification Z-IV. Note the increased
overestimation in patient 12 compared to patient 1, and the amount of segmentation spikes in

the conventional obturators.
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3.4 Discussion

This retrospective study verified the closed surface model obturator by comparing the shape,
volume, and weight reduction with Ooms' classified conventional obturators. The theoretical
maximum achievable weight reduction was 69%, and the 0.8 scaled bone-CSM design and clinical
reference designs achieved an average weight reduction of 47%.

3.4.1 Interpretation of results

The Pearson's correlation coefficient between volumes and the absolute weight reduction
calculated for the bone-CSM was close to the value one, which shows a high direct positive
correlation. The correlation indicated that the weight reduction increased for larger obturator
volumes. Nevertheless, the percentage weight reduction results showed that volume did not
influence the reduction as seen by the horizontal correlation plots. Furthermore, the weight
reduction values of the TCR and bone-CSM designs had comparable results. These findings
enhanced the use of the CSM method. Though, the volumes of the bone & soft tissue-CSM designs
were often too large, resulting in a weight gain instead of a weight reduction. For this reason, these
designs were excluded from the weight reduction results. These findings, however, did not
correspond with the previous clinical-trial research results for those Ooms’ classes.

The 0.8-scale was also based on the clinical results of Chapter 2. The results in Figure 3.10
compared the weight reduction for different scales of an average-sized obturator and showed
exponential growth. A larger scale will thus result in more weight reduction with a maximum of
70% (TMR) due to the weight of the Clear resin. The TMR, however, is not clinically feasible
because of the missing denture relining material, which deteriorates the clinical fit and does not
allow post-operative adjustments by the prosthodontist. Therefore, it is essential to find a scale
that balances clinical usability and weight reduction, in which the results suggested the 0.8-scale.
Even though this scale does not achieve the maximum weight reduction, the 40-50% reduction is
larger compared to literature stating that a hollow obturator reduces the weight by 7 - 33% [35].
The next step for future research would be optimizing the scale and final shape of the CSM
obturator.

The two bilateral cases resulted in significant outliers in the weight reduction results.
Therefore, they were excluded from the shape and volume results. Also, the Ooms' classification
system only considers unilateral resections. The bilateral cases, classed as A-IV and Z-1V, were
controversial with these terms. Expanding the classification system or designing a separate
system would allow the inclusion of bilateral cases.

Turning now to the shape results, which were assessed by the HDs. There were significant
differences between the maximum HD and the 95% HD. The resolution of the segmentations could
be a possible explanation, which will be discussed in the next section. The mean average HD and
95% HD were less than 5mm for the bone-CSM designs. Although we desired that the CSM designs
were not exceeding the conventional obturator shape, it needs to be considered that the scans
were made within an average of six weeks after surgery. The first clinical case (Chapter 2)
indicated that the size of the conventional obturator decreased by 10 - 15 mm after 7 weeks of
surgery (Figure 2.19). Therefore, we expected that the segmented obturators were larger directly
after surgery than visible on the postoperative CT scans, which probably resulted in higher HD
values. For this reason, the prosthodontist still considered the bone-CSM designs clinically useful,
despite some of the red overestimated areas as seen in the color-coded distance maps in Appendix
H1.

Regarding the Ooms’ classification system, the 'Z'-classes had a larger volume than the 'A'-
classes, especially the Z-IV classes. This result followed our expectations based on the increased
height and width of the resections for those classes (Figure 3.5). Ooms' classes A-II and A-III had
the smallest obturator volume and the least weight reduction (<20 gram). It should be researched
whether those types of obturators have enough physical impact on the patient and, therefore, see
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whether it is feasible designing them. Even though this study failed to demonstrate the bone- and
soft tissue CSM weight reduction, the volume differences between the classes suggested that
obturators can be classified and that these classes may need different CAD/CAM design
approaches. Yet, it needs to be considered that the number of cases per class in this research
cohort was not equal.

3.4.2 Strength and weaknesses

The study had multiple limitations. First, there were limitations regarding the population size. The
research cohort was relatively small due to the lack of postoperative CT scans, which resulted in
exclusion of maxillectomy patients. The population size limitation mainly affected the obturator
comparison between the Ooms' classification classes. However, this was not the main objective of
this study. More cases in different classes would provide more knowledge for the (future) CSM
designs. Future cooperation with other hospitals could enlarge the cohort. Despite the population
size, the Pearson's correlation plots showed significant results and provided insight in the clinical
applicability of the CSM designs.

Second, there were limitations regarding the accuracy of the CT scans. The scans with a
larger slice thickness (>1 mm) affected the resolution of the skull and resection margin
segmentations. Hence, soft tissue could not always be segmented, and classes could not be
distinguished very well. The resolution could lead to too sharp protruding edges and
overestimations in the CSM designs. For example, the sharp edges caused an increased HD in case
11, caused by a slice thickness of 5 mm. Usually, these edges would manually be smoothed and
removed before clinical implementation (see methods chapter 2), which probably would have led
to a lower HD. These manual alterations were not made to prevent inter-observer variability in
designing the obturators. Still, the volume of the bone-CSM designs were considered useful based
on the minimal HD overestimations, despite the lack of alterations. Furthermore, the accuracy of
the CT images sometimes resulted in holes and spikes within the conventional obturator
segmentations, which could have led to an under- or overestimation of the obturator volume,
respectively. Although the slice thickness affected the results, it needs to be considered that
nowadays, CT scans are often made with a slice thickness of 1 mm, which minimizes this limitation
regarding accuracy.

Third, the use of segmented soft tissue as a design method for the bone & soft tissue- CSM
designs was questioned by the results. For example, cheek fat was included in the Z-II and Z-1V
designs. The cheek fat, however, was often crooked in the scan by the tumor. In addition, the
mastication muscles for classes A-II and A-IV were sometimes hard to distinguish in the scans
because of the slice thickness or scattering. As an alternative in future designs, the lateral side of
bone-CSM designs could be enlarged, similar to the fourth clinical case of Chapter 2. The
enlargement resulted in the best clinical fit, which indicated that this could be an alternative
method for the Ooms classes with a wide obturator volume.

Fourth, the pre-and postoperative CT scans were registered by one observer, causing
inter-observer variability, in which the registration error was not measured. On the other hand,
the whole skull was registered with multiple notable features at different locations, such as the
infraorbital foramen (Chapter 1 Figurel). Also, Chapter 2 indicated that the FPR method resulted
in a minimal error (<1mm). Therefore, it is expected that the registration error in this study would
have been similar and had minimal effect on the results.

Finally, it needs to be considered that all calculations were digitally measured and do not
simulate any clinical conditions. Although the densities used in this research were based on
clinical experiments, the water and bacteria uptake in the putty obturators could have differed in
each case, affecting the actual weight. Also, the results lack information about the material
properties of the designs in terms of strength and fracture load. In addition, the clinical fit of the
CSM designs was not researched in this study and should be considered in future randomized
control clinical trial studies.
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3.4.3 Future recommendations

A larger cohort in future research would gain more information about the differences in shapes,
volume, and weight reduction between the CAD/CAM designs and the conventional ISOs. In
addition, it is expected that a larger cohort would allow more Ooms’ class distribution and
therefore more insight into the shape prediction for CAD/CAM designs, since no research has
previously been published on this subject. Though, slight alterations in the design methods need
to be made for the Ooms’ classes A-1I, A-1V, Z-11, and Z-1V that result in the bone-and soft tissue-
CSM obturators. Furthermore, the classification could be expanded, or classes could be combined
to allow the inclusion of bilateral cases.

The question raised by this study is thus whether the use of segmented soft tissue is the
optimal method to enlarge the CSM design. It is recommended to use other strategies, such as
enlargement of the bone-CSM in the lateral direction, as used in one of the designs in the previous
chapter. On the other hand, the shape, volume, and weight-reduction results of the bone-CSM,
together with the clinical results of Chapter 2, indicate a clinically valid method for designing
CAD/CAM obturators. Future research should further optimize these methods, including
optimizing the 0.8-scale.

On the other hand, this study raised the question whether the limitations, such as the CT
accuracy and the underestimated volume of the segmented conventional obturators, affected the
results. Also, no manual alterations were made to the CSM designs which would have altered the
shape by cutting off the sharp edges. It is recommended for future research to focus more on a
clinical-trial study rather than a retrospective study due to these limitations. In addition, a
retrospective study does not gain information about the clinical fit.

3.5 Conclusion

The purpose of the current retrospective study was to verify the digital hollow CSM design
according to the Ooms' classification system in terms of weight reduction, shape, and volume.

The findings in this study confirmed that the bone-CSM design is a promising CAD/CAM
method for replacing conventional ISOs. The forthcoming steps would be to investigate the clinical
fit by implementation through a randomized clinical-trial study and to investigate the safety of the
designs by researching the material properties.

Additional improvements of the Ooms' classification are needed to allow direct shape
prediction of the ISO shapes. Furthermore, the designs need further optimizations in the scale and
design methods for the larger obturators.
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4. Material properties of
the CSM obturator

4.1 Introduction

The previous chapters assessed multiple factors such as the shape, volume, and weight reduction
of the novel CAD/CAM obturator prosthesis. Another essential aspect before clinical
implementation is the research of the biomechanical behavior of the obturators. Although the
prosthesis design could be very comfortable for the patient, it could be, on the contrary,
susceptible to fracture. In general, the mechanical failure in the acrylic resin can be enhanced by
the oral cavity because of the unfriendly environment that presents temperature, pH variation,
and fatigue cycling. In addition, water absorption occurs in acrylic resins causing dimensional
instability, which reduces the tensile strength of the material and eventually could lead to fracture
[68]. Therefore, the dimensional stability of prosthetic devices, associated with their retention and
comfort, is an important parameter.

Besides the demands of the oral cavity, the prostheses are exposed to gravity-induced
stress and chewing load. Furthermore, the obturator can experience increased mechanical stress
during the prosthesis removal for cleaning or adjustment purposes during the follow-up visits. It
is expected that prosthetic devices such as the obturator prosthesis could stand out against both
the aging effect and the bending moment during insertion and removal of it in the patient’s mouth.

According to a literature review, the key factor for the success or failure of this treatment
modality is to evaluate the pattern in which stresses are transferred to the prosthetic device [69].
However, most of the available studies only consider the chewing load simulation instead the
stress generated during the prosthesis removal [70]. One viable method for clinicians to assess
prostheses deformation due to the oral cavity environment is with the aid of 3D models
superimposition and intraoral scanners [71]. Additionally, the fracture resistance of the
prosthesis can be measured with compressive loading using a universal testing machine.
However, to our knowledge, there is a lack of data about obturator prostheses in the literature,
especially for prostheses made by additive manufacturing through 3D printing [72].

Another widely used tool to assess the mechanical behavior of removable partial
dentures, prostheses, and supporting structures is finite element analysis (FEA). FEA provides
digital quantitative 3D information in which the loading and stress distribution can be simulated
from 3D model data. For the FEA simulation, a certain load can be applied to the chosen area of
interest with additional boundary conditions [69] [73],[74], [75].

4.1.1 Study aim

This study aimed to evaluate whether the CSM designs are limited to the demands of the oral
cavity and mechanical stress during the prosthesis removal. These mechanical properties are
analyzed by using one of the CSM designs in chapter 2. The hypothesis was that most stress during
the prosthesis removal would occur in the sharpest angles of the prosthesis, which is at the
connection between the baseplate and obturator. In addition, it was expected that the prosthesis
was resistant to the simulated oral cavity environment.
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4.2 Methods

4.2.1 Pre-processing

The best-fitted CSM design of the fourth clinical maxillectomy patient (Chapter 2.3.3, Figure 2.18
C) was chosen to research the mechanical behavior. The prosthesis was printed (Figure 4.1) six
times in Clear resin using the identical settings as the clinical case study of Chapter 2. Each design
was numbered for identification and scanned using the 3Shape TRIOS scanner (see Figure 1.10).
To improve the scanning accuracy, the surfaces were coated with powder and additional color
variation was created with permanent markers [76].

Figure 4.1. Three-dimensional (3D) printed computer-aided and manufactured designed
immediate surgical obturators.

Next, the prints were weighted using the Mettler-Toledo analytical balance and placed for
three weeks in water with a temperature of 37° Celsius to simulate the aging in the oral cavity
(Figure 4.2). The prints were dried and weighed again to measure the water absorption. In
addition, the prostheses were intraoral scanned again to measure the material stability which will
be further explained.

Figure 4.2. Experiment tools. A) Material weighting using the Mettler-Toledo analytical
balance. B) Stove with the prosthesis placed in 37° Celsius heated water.
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4.2.2 Compressive resistance test

The fracture mechanic performance of the prostheses was researched by a compressive
resistance test (see Figure 4.3). The prostheses were clamped at the obturator side and vertical
compressive forces with a linear speed of 1 mm/min were applied through a screw using the
Instron machine (Model no. 6022, Instron Ltd., Buckinghamshire, UK). Dental composite resin
was added in place of compression for the stabilization of the screw.

Figure 4.3. Vertical applied load (red arrow) on the fixated obturators using the Instron 6022
machine.

4.2.3 Digital analysis

To measure the material stability by the aging simulation, the optical scans were superimposed
by using the best-fit alignment and compared in a 3D inspection software program (GOM Inspect
2019; GOM) [77]. The material stability analysis was evaluated with color-coded maps and with
absolute deviations.

Figure 4.4. Best-fit alignment of the intraoral scanned prosthesis. A) Before alignment. B)
After alignment.

4.2.4 Finite element analysis

For the FEA, the STL files containing the intraoral scans were converted to a standard for the
exchange of product (STEP) format to the CAD software (ANSYS 19.2; ANSYS Inc., Houston, TX,
USA) [70], [78]. A 3D mesh of an intraoral scan was generated (Figure 4.5A). The Clear resin elastic
modulus (2.8 GPa), and a Poisson ratio of 0.3 based on acrylic resin dentistry, were assigned to
the mesh [79], [80]. Similar to the compressive test, the prosthesis was constrained at the
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obturator side and a vertical load was applied to the lateral side, opposite to the obturator. The
load magnitude was the average fracturing load defined by the in-vitro compressive test. The
tensile stress and deformation after removal of the prosthesis in the patient’s mouth were
simulated with this FEA set-up [70], [81].

Figure 4.5. 3D models in Ansys. A) Mesh. B) Constraint obturator (purple) with an applied
vertical load on the opposite lateral side of the baseplate (red arrow).

VAN

OF TWE NTE. LEEUWENHOEK

NEDERLANDS KANKER INSTITUUT

UNIVERSITY ‘@



Material properties of the CSM obturator

4.3 Results

4.3.1 Compressive resistance test

The results of the compressive resistance test are presented in Table 4.1, the average fracturing
load is about +25 N. Furthermore, prostheses 1-3 were not sealed enough, and therefore water
leakage occurred within the obturator (Figure 4.6 A). The table also presents the weight
differences, in which the sealed prosthesis (number 4-6) showed the least weight increase
percentage of around 2%.

Table 4.1. Weight and fracturing load results of the compressive resistance test.

No W?;‘();ht Weight (g) Weight increase Sealing Fracturing load
) TO T1 (%) capability (N)
1 9.87 10.15 2.84 No -30.62
2 9.84 10.38 5.48 No -17.35
3 9.92 10.56 6.49 No -23.05
4 10.00 10.22 2.16 Yes -36.06
5 9.99 10.21 2.22 Yes -26.12
6 9.93 10.15 2.16 Yes -17.78
uro  9.92+0.06 10.28+0.16 3.56£1.92 - 25.16+7.34

Figure 4.6 B shows the results of the fracture locations of the six baseplates after the compressive
resistance test. As seen in the Figure, all prostheses fractured at the transition side between the
obturator and baseplate.

Figure 4.6. Prostheses after the aging simulation and compressive resistance test. A) Water
leakage (black arrow) in the obturator. B) Fracture locations after the applied load.

4.3.2 Material stability analysis

Figure 4.7 shows the results of one of the prosthesis material deformities, presented with color-
coded maps in the GOM software. As seen by the figure, the vast majority of the prosthesis is
colored green, indicating no deformation. The highest value (+1 mm) was noticed at the lateral
side of the baseplate opposite to the obturator. In addition, the palate midline shows a deformity
of (0.5 mm).

Table 4.2 shows similar material stability results as Figure 4.7, presented in absolute
deviations of all prostheses. No alignment was possible for prosthesis number 4. As seen in the
table the average deviation is 1.38 mm, and the maximum deviation value is 1.82mm.

UNIVERSITY o 5
OF TWENTE LEEUW:E_W\C}?E L iy

ANKER INSTITUUT



Material properties of the CSM obturator

[mm]

s 1.00

0.80
0.60
~ 040
0.20
0.00
-0.20
-0.40

-0.60

B -0.80

-1.00
o

Figure 4.7. Material deformity after the aging simulation. A) Bottom surface. B) Upper surface.

Table 4.2. Absolute deviations of the material deformities.
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4.4.3 Stress assessment

Figure 4.8 shows the results of the tensile stress after the obturator constraint and applied average
fracturing load of 25 N (Table 4.1) in ANSYS. As seen by the upper surface (Figure 4.8 A), the
highest and most tensile stress is generated at the connection side between the baseplate and
obturator. The tensile stress peak was 67.4 MPa.
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Figure 4.8. Tensile stress generated in the prosthesis. A) Upper surface. B) Bottom surface.
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Figure 4.9 shows the deformation results of the prosthesis after the constraint of the
obturator and the applied vertical load on the lateral side of the baseplate in ANSYS. Similar to the
compressive test, the prosthesis showed elastic behavior before fracture and deforms according
to the simulation with a minimum of 0 mm on the obturator side, and with a maximum of 19 mm
on the opposite side.
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Figure 4.9. Deformation of the prosthesis during incidence of removal force.
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4.4 Discussion

This material property study aimed to predict the clinical reliability of a Clear resin CAD/CAM
designed immediate surgical obturator in the oral cavity environment and researched the
mechanical stress during the prosthesis removal. In the present study, water absorption of 2%
and material deformation at the thinnest, lateral side of the baseplate were observed, rejecting the
null hypothesis.

4.4.1 Interpretations of results

Researching the mechanical properties are important in the field of maxillofacial prosthetics and
removable dentures. Several studies use FEA to study the stress distribution in maxillofacial
obturator prostheses. For example, Harihara Sudhan et al. 2020 used FEA to study the tensile
stress in different definitive CAD/CAM-designed obturators after a digitally applied chewing load
of 150 - 250 N [82]. The study of de Sousa et al. (2014) used FEA to research the stress on
implanted-supported obturator prostheses for edentulous patients. They used an applied force of
35 N and 80 N, representing the maximum occlusal (jaw enclosing) force of the surface of the
anterior and posterior teeth, respectively [83]. In the present study, FEA was used with a vertical
applied load of 25 N, aiming to simulate the pulling of the prosthesis during removal.

In addition to the in-vitro experiment, the present investigation used a numerical
approach by FEA. The FEA, however, does not consider all the conditions found in the oral
environment. The oral cavity eases the water uptake due to thermal changes and moisture
contamination, causing internal stress and could eventually result in fracture [84]. The extent and
rate of water uptake of the denture resins depend on the material polarity. Yet, it was expected
that a longer aging simulation than the three weeks would have not altered the chemical reaction
(i.e., the 2% water absorption). It was also highly expected that the lack of decent sealing was
caused by the insufficient enclosing of the print holes with TAB-2000 powder (see Chapter 2),
which resulted in the larger weight increase percentages.

The use of a virtual model superimposition to evaluate printed structures’ stability has
been already reported in literature. For example, the study by Goodacre et al. (2016) used this
method to compare the denture base adaptation of conventional and CAD/CAM fabricated
complete dentures [85]. The CAD-CAM denture was found to be the most accurate and
reproducible denture fabrication technique. As seen in the literature, the use of a virtual model
superimposition allows for a fast and highly accurate evaluation [77]. Structure stability studies
of the 3D printed maxillofacial prosthesis, however, are lacking. However, in the present study,
the effects of 37° C water uptake were investigated, which resulted in a bending of the material at
the most lateral side of the baseplate, opposite to the obturator. This location was not surprising,
considering this is the thinnest part of the prosthesis. Also, the deformation in this specific location
was about 1mm, which probably would not have a severe consequence for the clinical fit. In
addition, in a clinical situation, the prosthesis is fixed to the palate and tight between the
remaining teeth in the patient’s mouth, which questions if the prosthesis would also deform as it
did here.

Moreover, the in-vitro compressive resistance test resulted in an average fracturing load
of 25 N, which resulted in a digital FEA tensile stress peak of 67.4 MPa at the connection side of
the baseplate and obturator. The tensile stress peak was similar to the maximum tensile strength
of 65 MPa of Clear resin, as stated by the manufacturer (Formlabs) [79]. These results increased
the reliability of the fracturing load results and the use of FEA for future mechanical properties
studies.

The compressive force, however, that is applied during prosthesis removal was not
previously researched, which raises the question of whether the fracture load of 25 N is clinically
reliable. The fracture load amount is, for example, far less than the average chewing load. The ISO,
however, other than the definitive obturator, has all its retention hooked around the patient's
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remaining teeth or zygoma bone. Therefore, the ISO experiences far less chewing load. In addition,
a previous finite element study simulated 10 N of force to remove a conventional full denture from
its position. Therefore, assuming this value as a threshold and the results from the present
investigation, the prosthesis design manufactured in this report would be able to resist the
removal force without fractures or mechanical complications [73]. Furthermore, both the in-vitro
test and FEA indicated the amount of bending behavior of the material before fracture. The
bending could be a warning for the prosthodontist and patient that a possible fracture occurs
when the removal continues at this position.

4.4.2 Strength and weaknesses

The present study had multiple limitations. First, this study researched only one ISO design. As
seen in the previous chapters, the maxillary defect and consequently the obturator prosthesis
differ in shape and size. Therefore, the mechanical stress distribution could vary in different
prosthesis designs. On the other hand, each design is made from the same material and consists
of the same two elements: the baseplate and the obturator. Thus, it is expected that these findings
will not highly differ from other prosthesis designs. The designs, however, could be optimized by
creating smoother and rounder shapes to strengthen the prosthesis. For example, at the transition
between the baseplate and the obturator because the results indicated the most stress here.

Second, the in-vitro compressive resistance test and FEA may not reproduce the oral
environment. On the other hand, the clinical conditions were simulated by the aging simulation.
As mentioned in the previous section, it was expected that the water leakage during the aging
simulation was caused by insufficient enclosing of the print holes. The executor of this step lacked
experience compared to a highly capable prosthodontist. Additionally, in a clinical situation, the
CAD/CAM prosthesis would be covered with reline material which would have further sealed the
prosthesis. Therefore, it is expected that there will be no water leakage in future clinical CAD/CAM
[SOs.

Third, the prostheses were printed in Clear resin for research purposes and cost savings.
For final clinical implementation, it is recommended to use a more biocompatible material such
as Dental Clear Resin (Formlabs). It is expected that this material is better resistant to the oral
environment. Furthermore, in terms of the oral environment, the aging simulation was limited to
the temperature of 37° Celsius. Varying temperatures, pH values, etc. were not studied.

Fourth, the in-vitro tests needed to be repeated several times because of the instability of
the screw on the surface of the prosthesis, even with the additional composite resin. Also, the
clamping of the obturator and the exact surface point where the vertical force was applied differed
slightly in each prosthesis. These factors contributed to the differences in the fracturing loads. On
the other hand, the average fracture loads resulted in very trustworthy results, as seen in the
tensile stress FEA measurements. Furthermore, the load was measured on only one surface
location at a time and only in one direction. The FEA can be expanded to different kinds of loads,
on multiple surface points in future research. Yet, it needs to be considered that it remains difficult
to digitally simulate the exact loads in all directions. A clinical trial study would be more helpful
than simulating it all.

Finally, to measure the digital material stability, the prostheses were intraoral scanned by
one observer, resulting in intra-observer variability. The registration error was not measured, but
this is the most precise scanner currently available. It is thus not expected that this affected the
results [46]. On the other hand, the scanner could not reach the whole surface of the medial side
of the obturator due to the relatively high palate blocking the scanner. Thus, the material
deformity was not measured across the whole surface.

4.4.3 Future recommendations

For the future clinical implementation of the prosthesis, it is recommended to optimize the design
to obtain its maximal strength. The optimization includes mainly the connection between the
baseplate and obturator. According to the results, this is likely the first location for the prosthesis
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to fracture. The optimization should include a more curved and smooth transition without
blocking the surrounding anatomical structures.

Furthermore, the results indicated that the experimental set-up for both the in-vitro test
and the FEA were reliable. Therefore, it is recommended to redo these experiments after
researching different designs or alterations. In addition, the clinical environment could be more
simulated in terms of varying temperatures and pH values. On the other hand, it needs to be
considered that it is difficult to simulate the exact clinical environment, which raises the question
of what more knowledge additional simulated data would gain. It would be recommended,
however, to compare the biocompatible Dental Clear resin using this set-up with the findings of
this research.

4.5 Conclusion

This study aimed to study the mechanical stress during removal of the Clear resin CAD/CAM
designed ISOs and whether these prostheses are consistent with the demands of the oral cavity.

The finite element analysis in this study indicated to be a reliable tool to predict the
mechanical stresses of the maxillary prosthesis. The most tensile stress was found at the
connection between the baseplate and obturator, which can be considered in future optimizations
of the CAD/CAM design. In addition, the material deformed at the thinnest part of the prosthesis
after the aging simulation. Using a more biocompatible material for future clinical implementation
could result in higher resistance against oral demands.
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Appendix

A1l: Protocol segmentation steps in Slicer

1. Load in your files. If desired, rename your files by double clicking on the name in .
Make sure that the Maxilla is aligned straight in the CT if so, skip step 2 and 3.

2. Go to Select Active Transform > Create new Linear Transform as > Fill

in name. Set CT to ‘ Transformed’ node and user the sliders to translate and rotate the CT.

Active Transform: | CT Transform

»  Information

~ Edit
~ Transform Matrix

1.00 0.00
0.00 1.00
0.00 0.00

~ Translation

LR e |
P e F
Is

Min | ~200.0000mm -

~ Rotation
IR
PA

s

Identity Invert +

¥ Display

= Apply transform

0.00
0.00
1.00

-

0.00
0.00
0.00

0.0000mm

0.0000mm

0.0000mm

200.0000mm -

0.0®

0.0%

0.0%

D o [0 [0

Transformable: Transformed:
Camera CT Head

™

84

3. Gobackto Data. Right click on the i next to the CT to switch the transform on and off. After
the transform, repeat this step and select Harden transform.

¥ Help & Acknowledgement

Subject hierarchy Transform hierarchy All nodes

Mode

%= CT Transform
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A1l: Protocol segmentation steps in Slicer

Example:

Before transform:

R: -134.880 Imm

_(.{- .
4. Go to Segment Editor and segment the skull. Select the CT as Master Volume > press Add.

Double Kklick on the segment name and color to change them. Go to Threshold and set the range
to the threshold of the bones. Press Apply.

Segmentation: | Segmentation &
Master volume: | CT Head A
I:Ei Add B R emove @ Show 3D b o Segmentations. .. o

- E Name R
BN B

UNIVERSITY aNTON! 8]
OF TWENTE lr;_,,-‘_,m.“ﬁf;}%ﬂ; 5



m A1l: Protocol segmentation steps in Slicer

5. Press Show 3D to have a 3D visualization of the skull. Use the buttons B1Ed to center to the
3D view or to quickly adjust the direction of the view. If needed, remove scatter or small segment
parts by combining with the other segment editor effects such as Scissors & Islands.

6. GotoConverters> B CropVome gojoct o Input Volume the CT and create a new annotation ROI
as Input ROI. Swipe the colored dots of the ROI to the range of the maxilla. Create a new Output
Volume as ‘Maxilla Volume’. Press Apply.

Example:
Input volume: | CT head -
Input ROT: Manilla ROI -
% Digplay ROI -@-Fit to Volume
Output volume: | Maxilla Vaolume -

Balita e somm =00 EQO@ < H WF-t- Ban +- @O

7. Go back to Segment Editor to segment the Maxilla. Select the Maxilla Volume as Master Volume
> press Add. Go to Threshold and press Apply. Repeat step 5.
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Al: Protocol segmentation steps in Slicer

8. Repeat step 6 and 7 to create a new ROI for the resection margins. Discuss the range of the ROI
with the head- and neck surgeon. This will be the horizontal and vertical resection margins. After
the discussion, crop a new Output Volume as ‘Resection Volume’. Next, repeat step 7 to segment
the resection margins.

Segmentation: |Segmemah'on

Master volume: | CT Head

| + Add | | = Remaove | | 0 Show 3D
- B Name

P Resection model

- Skull

- . Maxilla

9. Go to Data. Make the resection segment visible and other segments non-visible. Right-click on the
resection segment and click on Export visible segments to models. A model of the resection margin
is created.

v CT Head
4= CT Transform
‘ Segmentation
@ Skul

B Maxila

Resection Margins

SR el g

Rename
Delete
Edit properties...
Create child folder
Clone

Export visible segments to binary labelmap

Export visible segments to models

10. Go to the arrow next to Fiducial > select Plane. Create a plane in the oblique resection direction
by selecting three points. The first two points (highlighted with a white arrow in the image below),
are set in the oblique direction that is discussed together with the surgeon. The final point is used
to determine the height of the plane. Use the one-dimensional views below your model to
determine the height and create a vertical plane in the same angle as the CT.

t- B R
Persistent
L Ruler
t. ror
4 | Fiducal
_'L Line
.:!- Angle
I;tj Open Curve
& Closed Curve

Plane

t. ror
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Al: Protocol segmentation steps in Slicer

11. Go to Surface Models >

12.

13.

& Dynamic Modeler and select Plane Cut % . Select your resection

model as Model node, your oblique plane as Plane Node, and create new models as Clipped
output models. Press Apply. Check in your data which side (positive or negative) is the
correct output model.

| * Input nodes |

Model node: |F‘.esecﬁun Model = |
Flane node [1]: |Plane M |
Plane node [2]: |None - |

~ Parameters |

Cap surface: v
Operation type: |Ur1icn - |

| * Qutput nodes |

Clipped output model (positive side): | Model_1 hd |

Clipped output model (negative side): | Model_2 - |

Your resection bone model is now completed. If alterations are needed, or navigation will be
used, go to Data > right click on the model > Convert model to segmentation node.

For the final step, make sure that you downloaded the ‘Slicer IGT" and ‘MarksupToModel’
extension.

Go to IGT > |7 Markups to Model | and select your finished resection model as Input node. As
Output model, create a new model. After a few seconds, a CSM design appears, set the
smoothing off for a more precise shape.

Parameter node: | MarkupsToModel

Model type: 'ZEZ' Closed surface 'Z:::Z' Curve

Input node: | Resection model

Output model: | CSM obturator

v Auto-update

| ~ Closed Surface Model Settings

Clean Duplicate Input Points Vv
Convexity 0.0
Smoothing

Force convex output v
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A1l: Protocol segmentation steps in Slicer _

14. Now it is time to register the baseplate. Load the intraoral scan in Slicer.

Go to IGT >  * Fidudal Regstration Wizard  and create new ‘From’ and ‘To’ fiducial registration
points, rename them if desired. Create a new linear transform as ‘I0S to CT’, for example.

|Frnm{IDS} - ”E”EJ m | ..¢'|

Label R A 5

* To fidudials

To (CT) ~ ||E||I,| i | _|

Label R A 5

¥ Place fidudals using transforms
Registration result (From->To) transform

105 to CT - |
Result transform type: '@:' Rigid ':::' Similarity ':::' Warping
Paint Matching Method: Manual = |
i Auto-update |

15. Set the fiducial points at the identical locations on the segmented CT skull and 10S. Chose
notable features at different areas on the teeth, for example at the most posterior locations as
seen in the image below:

The Fiducial Registration Wizard extension automatically calculates the RMS if all the points
are set, the error should be <1mm.
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m A1l: Protocol segmentation steps in Slicer

16. Repeat step 3: Go back to Data. Right click on the i next to the intraoral scan and transform.
To harden the transform, select Harden transform. The intraoral scan is now registered,
which should look like the image below for example:

»

)
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3.

4.
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A2: Protocol Metronics navigation preparation steps in Slicer

Go to Data > Select your final ‘Resection Model. STL’ > right click on the model > Convert model
to segmentation node.
Go to # Segment Editor > select the correct Segmentation > select the resection bone
segment > click right next to Segmentations > press ‘ Export to files..’

Segmentation: | Resection Model-segmentation -
Master volume: | CT Head “

F? Add N [ emoyve a Show 3D o @ Segmentations... |~
Importfexport nodes. .

T Moo R e

The ‘Export segments to files’ pop-up appears, select your Destination folder, set the CT as
Reference Volume and select NRRD as File Format. Press Export.

B Export segments to files ? x

Destination folder: C:fUsers/a.0omsDesktop (=

Visible segments only:
Reference volume: T Head -
File format: MRRD -
Merge into single file:

Size scale:

Coordinate system:
Use compression:
Use color table values:
Show destination folder: |v
Export

Import the exported resection NRRD in your Slicer.

Go to Filtering > Arithmetic > % Multply Scalar Volumes 1 4 select your CT as ‘Input Volume

1 and your resection volume as Input Volume 2. Create a new output file as Output Volume, for
example: Multiplied Volume. Press Apply.

o Subtract Scalar Volumes

UF TWENTE LEEUWENHOEK
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A2: Protocol Metronics navigation preparation steps in Slicer

5. Goto Filtering > Arithmetic > and selectyour CT as Input Volume 1 and your multiplied volume
as Input Volume 2. Create a new output file as Qutput Volume, for example: CT Head - Resection.

Press Apply .
Input Yolume 1 | CT Head -
Input Volume 2 | Multiplied Volume -
Output Volume | CT Head - Resection -

6. The output volume contains the original CT with the resection margins subtracted from the CT in
grey. Repeat step 4 if you desire the resection area to be more darker.

B: CT Head - Resection B: CT Head - Resection

7. Go to > right click on the output volume > press Export to DICOM and select the
desired folder. The DICOM file can be exported and loaded into the Medtronic with an USB flash
drive.

Mode -
ﬁ CT Head &
~ & Segmentation -
& Resection bone ok
& Resection bone volume g i
ﬁ Multiplied Volume '
P

¥ CT Head - Resection

Rename

Delete

Edit properties. ..
Create child folder
Clone

Register this...

Convert to RT dose volume. ..

Export to DICOM. ..
Segment this. ..
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B1: Python scripted resection segmentation steps in Slicer

e Load in the CT data.

e Go to View > Python Interactor (ctrl + 3)

e Copy (ctrl + c) - paste (ctrl + v) the code lines displayed per block into the Python
interactor

Step 1: Transform (if needed)

#Create transform

# Create transform

masterVolumeNode = getNode("CT Head") #fill in name of CT scan #fill in name of CT scan
transformNode = slicer.mrmlScene.AddNode(slicer.vtkMRMLTransformNode())
transformNode.CreateDefaultDisplayNodes()
slicer.util.selectModule("Transforms")

transform = vtk.vtkTransform()

print(‘rotate or transform’)

# Transform CT

transformNode.ApplyTransform(transform)
masterVolumeNode.SetAndObserveTransformNodelD (transformNode.GetID())

Step 2: Segment skull

#Create segmentation node

masterVolumeNode = getNode("CT Head") #fill in name of CT scan

segmentationNode = slicer.mrmlScene.AddNewNodeByClass("vtkMRMLSegmentationNode")
segmentationNode.CreateDefaultDisplayNodes()
segmentationNode.SetReferencelmageGeometryParameterFromVolumeNode(masterVolumeNode
)
addedSegmentID = segmentationNode.GetSegmentation().AddEmptySegment("Skull")
segmentation = getNode('Segmentation')

segmentID = 'Skull' #name of segmentation

# Segment color

segment = segmentation.GetSegmentation().GetSegment(segmentID)
segment.SetColor(241/255, 214/255, 145/255) # bone color
slicer.util.selectModule("SegmentEditor")

# Create segment editor to get access to effects

segmentEditorWidget = slicer.qMRMLSegmentEditorWidget()
segmentEditorWidget.setMRMLScene(slicer.mrmlScene)
segmentEditorNode = slicer.mrmlScene.AddNewNodeByClass("vtkMRMLSegmentEditorNode")
segmentEditorWidget.setMRMLSegmentEditorNode(segmentEditorNode)
segmentEditorWidget.setSegmentationNode(segmentationNode)
segmentEditorWidget.setMasterVolumeNode(masterVolumeNode)

# Thresholding
segmentEditorWidget.setActiveEffectByName("Threshold")

effect = segmentEditorWidget.activeEffect()
effect.setParameter("MinimumThreshold","400") #Change if needed
effect.setParameter("MaximumThreshold","3000")
effect.self().onApply()

#Keep largest island to remove noise
segmentEditorWidget.setActiveEffectByName("Islands")
effect = segmentEditorWidget.activeEffect()
effect.setParameter("Operation”,"KEEP_LARGEST_ISLAND")
effect.self().onApply()
segmentEditorWidget.setActiveEffectByName("None")

=
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B1: Python scripted resection segmentation steps in Slicer

#2 Segmentation skull: Visualize in 3D
print ('Please be patient, the segmentation is loading and will appear when it is finished")
segmentationNode.CreateClosedSurfaceRepresentation()

#set orientation on segmentation
layoutManager = slicer.app.layoutManager()
threeDWidget = layoutManager.threeDWidget(0)
threeDView = threeDWidget.threeDView()
threeDView.resetFocalPoint()

Step 3: Segment Maxilla

#Create ROI
segmentationNode = getNode(“Segmentation”)

# Compute bounding boxes

import SegmentStatistics

segStatLogic = SegmentStatistics.SegmentStatisticsLogic()
segStatLogic.getParameterNode().SetParameter(“Segmentation”, segmentationNode.GetID())
segStatLogic.getParameterNode().SetParameter(“LabelmapSegmentStatisticsPlugin.obb_origin_ras
.enabled”,str(True))
segStatLogic.getParameterNode().SetParameter(“LabelmapSegmentStatisticsPlugin.obb_diameter_
mm.enabled”,str(True))
segStatLogic.getParameterNode().SetParameter(“LabelmapSegmentStatisticsPlugin.obb_direction_
ras_x.enabled”,str(True))
segStatLogic.getParameterNode().SetParameter(“LabelmapSegmentStatisticsPlugin.obb_direction_
ras_y.enabled”,str(True))
segStatLogic.getParameterNode().SetParameter(“LabelmapSegmentStatisticsPlugin.obb_direction_
ras_z.enabled”,str(True))

segStatLogic.computeStatistics()

stats = segStatLogic.getStatistics()

# Draw ROI for each oriented bounding box
import numpy as np
for segmentld in stats[“SegmentIDs”"]:
# Get bounding box
obb_origin_ras = np.array(stats[segmentld,”LabelmapSegmentStatisticsPlugin.obb_origin_ras”])
obb_diameter_mm =
np.array(stats[segmentld,”LabelmapSegmentStatisticsPlugin.obb_diameter_mm”])
obb_direction_ras_x =
np.array(stats[segmentld,”LabelmapSegmentStatisticsPlugin.obb_direction_ras_x"])
obb_direction_ras_y =
np.array(stats[segmentld,”LabelmapSegmentStatisticsPlugin.obb_direction_ras_y”"])
obb_direction_ras_z =
np.array(stats[segmentld,”LabelmapSegmentStatisticsPlugin.obb_direction_ras_z"])
# Create ROI
segment = segmentationNode.GetSegmentation().GetSegment(segmentld)
roi=slicer.mrmlScene.AddNewNodeByClass(“vtkMRMLAnnotationROINode”)
roi.SetName(“MaxillaROI")
roi.SetXYZ(0.0, 0.0, 0.0)
roi.SetRadiusXYZ(*(0.5*obb_diameter_mm))
# Position and orient ROI using a transform

obb_center ras = obb_origin_ras+0.5*(obb_diameter mm[0] * obb_direction_ras.x +
obb_diameter_mm|[1] * obb_direction_ras_y + obb_diameter_mm][2] * obb_direction_ras_z)
boundingBoxToRasTransform = np.row_stack((np.column_stack((obb_direction_ras_x,

obb_direction_ras_y, obb_direction_ras_z, obb_center_ras)), (0, 0, 0, 1)))
boundingBoxToRasTransformMatrix =
slicer.util.vtkMatrixFromArray(boundingBoxToRasTransform)
transformNode = slicer.mrmlScene.AddNewNodeByClass(“vtkMRMLTransformNode”)
transformNode.SetAndObserveMatrixTransformToParent(boundingBoxToRasTransformMatrix)

5
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B1: Python scripted resection segmentation steps in Slicer

roi.SetAndObserveTransformNodelD(transformNode.GetID())
Set ROI on the maxilla before continuing with the next step..

#Cropp Volume to Maxilla

masterVolumeNode = getNode("CT Head") #fill in name of CT scan
ROINode = roi

ROINode.SetName(‘MaxillaROI")

#This cell crops the volume by the selected maxilla ROI
MaxillaVolumeNode = slicer.vtkMRMLScalarVolumeNode()
MaxillaVolumeNode.SetName(‘MaxillaVolume’)
slicermrmlScene.AddNode(MaxillaVolumeNode)

cropVolumeLogic = slicer.modules.cropvolume.logic()

cropVolumeParameterNode = slicer.vtkMRMLCropVolumeParametersNode()
cropVolumeParameterNode.SetROINodelD(roi.GetID())
cropVolumeParameterNode.SetInputVolumeNodelD(masterVolumeNode.GetID())
cropVolumeParameterNode.SetOutputVolumeNodelD(MaxillaVolumeNode.GetID())
cropVolumeParameterNode.SetVoxelBased(True)
cropVolumeLogic.Apply(cropVolumeParameterNode)

croppedVolume = slicer.mrmlScene.GetNodeByID( .GetOutputVolumeNodelD())

# Segment Maxilla

# Create segmentation maxilla

slicer.util.selectModule("SegmentEditor")
segmentationNode.SetReferencelmageGeometryParameterFromVolumeNode(MaxillaVolumeNode
)
addedSegmentID = segmentationNode.GetSegmentation().AddEmptySegment("Maxilla")
segmentation = getNode('Segmentation")

segmentID = 'Maxilla’'

# Segment color (blue)
segment = segmentation.GetSegmentation().GetSegment(segmentID)
segment.SetColor(111/255, 184/225, 210/225) # blue color

#select maxilla segment with the maxillaROI
segmentEditorNode.SetSelectedSegmentID(addedSegmentID)
segmentEditorWidget.setMasterVolumeNode(MaxillaVolumeNode)

#Threshold Maxilla segmentation
slicer.util.selectModule("SegmentEditor")
segmentEditorWidget.setActiveEffectByName("Threshold")

effect = segmentEditorWidget.activeEffect()
effect.setParameter("MinimumThreshold","400") #Change if needed
effect.setParameter("MaximumThreshold","3000")
effect.self().onApply()

#Keep largest island to remove noise + mandibula
segmentEditorWidget.setActiveEffectByName("Islands")
effect = segmentEditorWidget.activeEffect()
effect.setParameter("Operation","KEEP_LARGEST_ISLAND")
effect.self().onApply()
segmentEditorWidget.setActiveEffectByName("None")

#set orientation on segmentation
layoutManager = slicer.app.layoutManager()
threeDWidget = layoutManager.threeDWidget(0)
threeDView = threeDWidget.threeDView()
threeDView.resetFocalPoint()

e
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m B1: Python scripted resection segmentation steps in Slicer

Discuss and set ROI on the resection margin together with head-neck surgeon before continuing
with the next step.

Step 3: Segment Resection
ROINode = roi
ROINode.SetName('ResectionROI")

#Cropp Volume to Resection

ResectionVolumeNode = slicer.vtkMRMLScalarVolumeNode()
ResectionVolumeNode.SetName('ResectionVolume")
slicer.mrmlScene.AddNode(ResectionVolumeNode)

cropVolumeLogic = slicer.modules.cropvolume.logic()

cropVolumeParameterNode = slicer.vtkMRMLCropVolumeParametersNode()
cropVolumeParameterNode.SetROINodelD(roi.GetID())
cropVolumeParameterNode.SetInputVolumeNodelD (masterVolumeNode.GetID())
cropVolumeParameterNode.SetOutputVolumeNodelD(ResectionVolumeNode.GetID())
cropVolumeParameterNode.SetVoxelBased(True)
cropVolumeLogic.Apply(cropVolumeParameterNode)

croppedVolume =
slicer.mrmlScene.GetNodeByID(cropVolumeParameterNode.GetOutputVolumeNodelD())

# Create resection segment

slicer.util.selectModule("SegmentEditor")
segmentationNode.SetReferencelmageGeometryParameterFromVolumeNode(ResectionVolu
meNode)

addedSegmentID =
segmentationNode.GetSegmentation().AddEmptySegment("Resectionbone")

segmentation = getNode('Segmentation')

segmentID = 'Resectionbone’

# Segment color (dark blue)
segment = segmentation.GetSegmentation().GetSegment(segmentID)
segment.SetColor(0/255,151/225,206/225) # dark blue color

ttselect resection segment with the resectionROI
segmentEditorNode.SetSelectedSegmentID(addedSegmentID)
segmentEditorWidget.setMasterVolumeNode(ResectionVolumeNode)

#Threshold resection

print ('Please wait, the segmentation is loading and will appear when it is finished")
slicer.util.selectModule("SegmentEditor")
segmentEditorWidget.setActiveEffectByName("Threshold")

effect = segmentEditorWidget.activeEffect()
effect.setParameter("MinimumThreshold","400") #Change if needed
effect.setParameter("MaximumThreshold","3000")

effect.self().onApply()

#Keep largest island to remove noise + mandibula
segmentEditorWidget.setActiveEffectByName("Islands")
effect = segmentEditorWidget.activeEffect()
effect.setParameter("Operation”,"KEEP_LARGEST_ISLAND")
effect.self().onApply()
segmentEditorWidget.setActiveEffectByName("None")

#set orientation on segmentation
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B1: Python scripted resection segmentation steps in Slicer

layoutManager = slicer.app.layoutManager()
threeDWidget = layoutManager.threeDWidget(0)
threeDView = threeDWidget.threeDView()
threeDView.resetFocalPoint()

roiNode = roi
roiNode.SetDisplayVisibility(0)

Step 4: Plane cut resection model

#Hide all segments except resection

displayNode = segmentationNode.GetDisplayNode()
displayNode.SetAllSegmentsVisibility(False) # Hide all segments
displayNode.SetSegmentVisibility('Resectionbone’, True) # Show specific segment

#Set Markuppoints

ws=slicer.qSlicerMarkupsPlaceWidget()
w.setMRMLScene(slicer.mrmlScene)

markupsNodelD = slicer.modules.markups.logic().AddNewFiducialNode()
w.setCurrentNode(slicer.mrmlScene.GetNodeByID(markupsNodelD))

# Show buttons
w.buttonsVisible=True
w.placeButton().show()
w.show()

#Create markupsplane
pointListNode = slicer.util.getNode("F")
planeNode = slicer.mrmlScene.AddNewNodeByClass('vtkMRMLMarkupsPlaneNode', 'Plane")
for cpldx in range(3):
pos = vtk.vtkVector3d()
pointListNode.GetNthControlPointPositionWorld(cpldx, pos)
planeNode.AddControlPointWorld(pos)

planeNode.SetDisplayVisibility (1)

#export segments to models

segmentationNode = getNode("Segmentation")

shNode = slicer.mrmlScene.GetSubjectHierarchyNode()

exportFolderltemld = shNode.CreateFolderltem(shNode.GetSceneltemID(),
"Segment_models")
slicer.modules.segmentations.logic().ExportAllSegmentsToModels(segmentationNode,
exportFolderltemld)

#Remove additional models
slicer.mrmlScene.RemoveNode(inputmodelNode)

Skull = getNode('Skull"); slicer.mrmlScene.RemoveNode(Skull)
Maxilla = getNode('Maxilla'); slicer.mrmlScene.RemoveNode(Maxilla)

#Define models

inputmodelNode=slicer.util.getNode("Resectionbone")
inputPlaneNode=slicer.util.getNode("Plane")

OutputPositiveModel= slicer.mrmlScene.AddNewNodeByClass("vtkMRMLModelNode")
OutputPositiveModel.SetName('Resectionbone_green")

OutputNegativeModel= slicer.mrmlScene.AddNewNodeByClass("vtkMRMLModelNode")
OutputNegativeModel.SetName('Resectionbone_blue")
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m B1: Python scripted resection segmentation steps in Slicer

#Plane cut using dynamic modeler

dynamicModelerNode =
slicer.mrmlScene.AddNewNodeByClass("vtkMRMLDynamicModelerNode")
dynamicModelerNode.SetToolName("Plane cut")
dynamicModelerNode.SetNodeReferencelD("PlaneCut.InputModel", inputmodelNode.GetID())
dynamicModelerNode.SetNodeReferencelD("PlaneCut.InputPlane”, inputPlaneNode.GetID())
dynamicModelerNode.SetNodeReferencelD("PlaneCut.OutputPositiveModel",
OutputPositiveModel.GetID())
dynamicModelerNode.SetNodeReferencelD("PlaneCut.OutputNegativeModel",
OutputNegativeModel.GetID())
slicer.modules.dynamicmodeler.logic().RunDynamicModelerTool(dynamicModelerNode)

#Set color of new models

Green = getNode('Resectionbone_green")
Green.GetDisplayNode().SetColor(15/255, 233/225, 149/225) # green color
Blue = getNode('Resectionbone_blue")
Blue.GetDisplayNode().SetColor(0/255, 151/225, 206/225) # dark blue color
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B2: Python scripted Metronics navigation steps for 3D Slicer

e Load in the CT data with the resection bone segmentation

e Go to View > Python Interactor (ctrl + 3)

e Copy (ctrl + c) - paste (ctrl + v) the code lines displayed per block into the Python
interactor.

#Navigation step 1: Create labelmap of resection bone
#Skip this step if you already have a .nrrd volume of the segment
segmentNames = ["Resectionbone"]

segmentationNode = getNode('Segmentation')
labelmapVolumeNode =
slicer.mrmlScene.AddNewNodeByClass('vtkMRMLLabelMapVolumeNode")
labelmapVolumeNode.SetName("Resection_LabelMap")
referenceVolumeNode = slicer.mrmlScene.GetFirstNodeByClass('vtkMRMLScalarVolumeNode")
for segmentName in segmentNames:
segmentlds = vtk.vtkStringArray()
segmentld =
segmentationNode.GetSegmentation().GetSegmentldBySegmentName(segmentName)
segmentlds.InsertNextValue(segmentld)

slicer.vtkSlicerSegmentationsModuleLogic.ExportSegmentsToLabelmapNode(segmentationNode,
segmentlds, labelmapVolumeNode, referenceVolumeNode)

#Navigation step 2: Multiply scalar volumes

vol_l1=slicer.util.getNode('bones") #fill in name of CT scan
vol_2=slicer.util.getNode('Resection_LabelMap') #or fill in name of nrrd volume of the segment
a = slicer.util.arrayFromVolume(vol_1)

b = slicer.util.arrayFromVolume(vol_2)

c=a*b

volumeNode_result = slicer.modules.volumes.logic().CloneVolume(vol_1, 'Multiply_volume")
slicer.util.updateVolumeFromArray(volumeNode_result, c)
setSliceViewerLayers(background=volumeNode_result)

#Navigation step 3: Subtract scalar volumes

vol_l1=slicer.util.getNode('bones") #fill in name of CT scan
vol_2=slicer.util.getNode('Multiply_volume")

a = slicer.util.arrayFromVolume(vol_1)

b = slicer.util.arrayFromVolume(vol_2)

c=a- (1.5*b) #1.5 to geta dark grey subtraction, you can in- or decrease the amount of substraction.
volumeNode_result = slicer.modules.volumes.logic().CloneVolume(vol_1, 'Substract_volume")
slicer.util.updateVolumeFromArray(volumeNode_result, c)
setSliceViewerLayers(background=volumeNode_result)

#Navigation step 4: Eport volume as dicom
volumeNode = getNode("Substracted_volume")
outputFolder = ‘... # fill in output folder

# Create patient and study and put the volume under the study

shNode = slicer.vtkMRMLSubjectHierarchyNode.GetSubjectHierarchyNode(slicer.mrmlScene)
volumeShItemID = shNode.GetltemByDataNode(volumeNode)
shNode.SetltemParent(volumeShltemID, studyltemID)

=
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(0l B2: Python scripted Metronics navigation steps for 3D Slicer

import DICOMScalarVolumePlugin
exporter = DICOMScalarVolumePlugin.DICOMScalarVolumePluginClass()
exportables = exporter.examineForExport(volumeShltemID)
for exp in exportables:
exp.directory = outputFolder
exporter.export(exportables)

VAN
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C: Protocol baseplate design in Autodesk Meshmixer

Healthy Individuals

1. Contour palatum
Select > Brush

vy

v

2. Create facegroup
Select > Modify > Create FaceGroup
(Ctrl + G)

v

3. Optimize & smooth boundary

Select > Modify > Optimize Boundary

Select > Modify > Smooth Boundary
(0), (B)

A 4

4. Offset 0.2 mm
Select > Edit > Offset
(Ctrl + D)

UNIVERSITY
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5. Separate
Select > Edit > Separate

()

v

6. Extrude
Select > Edit > Separate

(D)

[
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D: Final designs in Autodesk Meshmixer

.
’ §

» L
-y
.V

Scale = 0.6 Scale = 0.7 . Hollow bulb

Figure D.1. Different scaled closed surface model (CSM) obturator designs (1-3), and the
hollow bulb design (4) in Autodesk Meshmixer.

Scale = 0.8

Figure D.3. Different types of digital immediate surgical obturator designs in Autodesk
Meshmixer. [: Hollow bulb. II: Intraoral scanned obturator. III: Two separated bone-and soft
tissue closed surface model (CSM). IV: Bone CSM. V: Manual shaped CSM. VI: Bone- and soft
tissue CSM.
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D: Final designs in Autodesk Meshmixer [{oE]

Scale = 0.8 +(5mm) Scale = 0.8 +(10mm) Scale = 1.0

Figure D.5. Closed surface model (CSM) obturator designs scaled to 0.8 (1-3) and 1.0 (4) in
Autodesk Meshmixer. The first obturator contains an additional zygoma-wiring boulder. The
lateral width of the second and third obturator is extended with 5 and 10 mm respectively.
bturator is extended with 5 and 10 mm respectively.

ws ol b

W O O R

Scale = 0.7 Scale = 0.8 Scale=1.0 Hollow bulb

Figure D.4. Different scaled closed surface model (CSM) obturator designs (1-3), and the
hollow bulb design (4) in Autodesk Meshmixer.
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E: Conventional surgical obturators, classified by the Ooms’
classification system.

(canine/premolar) ' > f y (molar 1-3)

Figure E.1. Examples of intraoral scanned immediate surgical obturators, classified according
to the Ooms’ ISO classification system.

UNIVERSITY “%
OF TWENTE. oo A A



105

F: Closed surface model obturators based on the Ooms’ obturator
classification system

Table F.1. Closed surface model designed immediate surgical obturators (ISO’s) for class Al -
A4 of the Ooms’ ISO classification system in 3D Slicer.

Class Resection bone Resection bone + Closed surface model
soft tissue

Al

A2
A3
A4
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F: Closed surface model obturators based on the Ooms’ obturator classification system

Table F.2. Closed surface model designed immediate surgical obturators (ISO’s) for class Z2 - Z4
of the Ooms’ ISO classification system in 3D Slicer.

Class Resection bone Resection bone + Closed surface model
Soft tissue

72

73

74
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G: Direct comparison results of the weight reduction,
volumes, and Hausdorff Distances

Table G.1. Direct comparison of the weight-reduction values for n=17.

Patient Class Theoretical Maximal Theoretical Clinical CAD/CAM

No. Reference Reference (Bone-CSM 0.8)
Weight Weight Weight Weight Weight Weight
reduction reduction reduction reduction reduction reduction

(2) (%) (2) (%) (2) (%)
1 Z3 41.73 69.66 27.99 46.72 26.80 44.73
2 74 87.35 75.27 58.21 50.16 52.12 4492
3 A3 40.20 68.80 27.19 46.54 2741 46.91
4 72 55.93 55.47 37.36 37.06 40.67 40.34
5 74 28.84 68.82 19.43 46.35 21.32 -50.86
6 74 58.82 56.69 39.65 38.22 59.90 57.74
7 A3 29.53 70.82 19.88 47.66 18.23 43.71
8 72 44.32 69.12 29.86 46.57 29.71 46.33
9 72 29.72 59.13 19.38 38.56 26.77 53.25
10 74 34.42 74.62 23.04 49.94 20.84 45.17
11 A4 41.10 73.16 27.28 48.56 24.23 43.14
12 74 52.96 69.66 35.80 47.09 38.89 51.16
13 74 80.27 72.71 52.76 47.80 56.83 51.48
14 74 69.49 75.97 46.43 50.76 54.77 59.88
15 A4 93.85 72.48 62.90 48.58 59.38 45.86
16 74 207.16 82.34 137.43 54.63 99.20 39.43
17 A2 31.71 69.70 21.31 46.83 15.71 34.53

HD: Hausdorff Distance; CSM = Closed Surface Model.
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G: Direct comparison results of the weight reduction, volumes, and Hausdorff Distances

Table G.2. Direct comparison of the volumes and Hausdorff Distances for the bone-CSM designs,

for n=17.

Patient Class Obturator volumes Conventional vs. CSM 0.8 (mm)

No. (cm3)

Conventional Bone HD HD HD 95th
CSM Maximum Average percentile

1 73 41.89 16.09 3.15 0.07 0.68
2 74 81.15 29.70 3.37 0.02 0.00
3 A3 40.86 17.59 6.20 0.43 3.00
4 72 70.5 18.78 0.00 0.00 0.00
5 74 29.31 18.78 8.01 0.71 3.62
6 74 72.55 45.18 14.79 1.77 8.25
7 A3 29.16 11.66 4.88 0.41 2.79
8 72 44.84 18.59 10.37 0.34 2.88
9 72 35.15 20.34 5.42 0.25 1.86
10 y2: 32.26 14.45 6.07 0.47 3.65
11 A4 39.28 14.86 10.77 0.23 1.77
12 74 53.16 27.23 16.16 1.31 8.74
13 y2: 77.2 37.78 13.03 0.93 5.30
14 74 63.96 42.92 9.25 1.09 5.61
15 A4 90.54 37.48 7.13 0.35 2.66
16 y2: 175.93 43.18 10.35 0.64 5.05
17 A2 3181 5.54 6.58 0.68 4.16

HD: Hausdorff Distance; CSM = Closed Surface Model.

Table G.3. Direct comparison of the volumes and Hausdorff Distances for the bone and soft-
tissue CSM designs, for n=11.

Patient Class Obturator volumes (cm3) Conventional vs. CSM 0.8 (mm)
No.
Conventional Bone & soft HD HD HD 95th
tissue CSM  Maximum  Average percentile
2 74 81.15 53.45 15.88 1.59 9.92
4 72 70.5 4427 15.57 2.03 7.63
5 74 29.31 31.40 14.22 1.84 8.10
6 74 72.55 61.04 16.65 2.43 8.74
8 72 4484 28.94 12.88 1.54 6.88
10 74 32.26 22.03 14.28 1.29 7.04
12 74 53.16 36.24 16.16 1.89 9.83
13 74 77.2 42.06 12.00 0.88 5.12
14 74 63.96 59.88 17.45 2.84 9.98
15 A4 90.54 65.45 6.80 0.36 2.79
16 74 175.93 70.22 10.33 0.60 5.01

HD: Hausdorff Distance; CSM = Closed Surface Model.
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H1: Distance maps Bone-CSM designs
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H1: Distance maps Bone-CSM designs
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H2: Distance maps bone & soft tissue CSM
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